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Introduction
Introduction
Most animal cells exhibit some form of motile behavior in the form of a change in cell shape or
cellular translocation. For years, cell biologists were limited to assessing these behaviors qualitatively,
which severely restricted their capacity to discriminate subtle changes. We now know that the motile
behavior of animal cells is quite complex and involves surprisingly large numbers of molecules
involved in signal reception, signal transduction, adhesion and cytoskeletal reorganization. Cellular
translocation and changes in cellular morphology are basic to embryogenesis as well as the maintenance
of the mature organism and the cellular immune response. Abnormalities in motility and cell shape can
play key roles in neoplasia and metastasis, as well as in congenital defects. It is, therefore, critical that
methods are developed which allow researchers to quantitate subtle as well as major changes in cell
shape and cellular translocation. The need for refined quantization has proved to be crucial in recent
studies of cells with mutations in specific cytoskeletal elements. These mutants are capable of growing,
developing and translocating. However, refined analysis of their motile behavior has revealed subtle
defects which have been crucial in interpreting the role of each cytoskeletal element in normal motility.
The methods which have evolved for analyzing how cells move and change shape are assisted
by computers, and the system we have developed at Solltech, Inc. represents the third generation of a
series of motion analysis systems which began to be developed in 1985 at the University of Iowa. The
first system, the Dynamic Morphology System (DMS), ran on a SUN computer, and a second version
was developed for the IBM-PC (AT). However, in 1989, the advantages of the Macintosh® platform
led to the development of a completely revised and advanced system for this platform, which is the
present Dynamic Image Analysis System (DIAS®). This system employs both QuickTime® and other
framegrabbers for image acquisition, and provides both automated and manual modes of digitization
for obtaining the perimeter of a moving cell. It includes image processing capabilities and a unique
method for generating a smoothed, continuous perimeter which is crucial for quantization. Most
importantly, DIAS® then computes more than 30 parameters of motility and dynamic morphology,
provides a mechanism which allows the user to generate customized parameters, and computes any or
all parameters every thirtieth of a second for up to 50 cells moving in parallel. DIAS® provides a
number of options for printing out data in tabular or graphic form, and will generate computer movies
of the digitized cell in a number of dynamic and, in some cases, unique formats. DIAS® is the
culmination of 12 years of programming. We believe it is the most unique dynamic morphology
system available.

A Brief Description of How a Biologist Uses DIAS®
DIAS® has been employed to analyze how microtubules, cells, larvae, worms and the left
ventricular cavity of the mouse and human heart move and/or change shape with time. Although we
will limit our discussion to its application to cell motility, it should be kept in mind that DIAS® can be
used for any object which changes shape and/or translocates, and which can be videorecorded.
In most cases, a cell biologist will employ DIAS® to characterize how a normal cell moves, or
to compare the behavior of an abnormal cell (e.g., a neoplastic or mutant cell) with its normal
counterpart. The cell image is videorecorded through a microscope in real time onto videotape or other
video recording device. If the cell or cells of interest are not in association with other cells, their
perimeters will be intact and distinguishable, and the user will have no problem manually digitizing the
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perimeter into the DIAS® data file. If the entire edge of the image contrasts with the substratum, the
automatic digitizing system can be employed. Therefore, the user should spend some time optimizing
the microscope format and illumination for recording the behavior of the cell or cells of interest. If a
cell of interest is in contact with other cells of equal contrast, it is unlikely that the automatic digitizing
mode of DIAS® can be employed.
To initiate an experiment, the user simply records the behavior of a cell through a videocamera
attached to a microscope. The microscope can be standard or inverted. The cell can be on any
substratum, on a slide, or in a chamber. As long as the user can distinguish the outline of the cell in the
recording, he or she will be able to analyze it. The recording is then frame-grabbed into DIAS®. If the
user wishes to analyze several cells in a single field, a lower magnification may be necessary. The user
must be aware that a cell may move out of the recording area, and the user may, therefore, wish to
initially decrease magnification, or move the recording area at some point during the recording period.
If the user wishes to use the automatic mode for digitization, the user will have to perform initial
experiments to adjust illumination in order to obtain high contrast cell substrate interphases which can
be identified by the DIAS® system. This usually involves illumination which results in a dark cell
image on a light substratum, but the reverse can also be effective.
Once the video is frame-grabbed into DIAS® as a DIAS® or Quick Time® movie, the user either
directs DIAS® to automatically digitize the perimeter of the cell(s) of interest, or manually traces those
perimeters. For automatic outlining, DIAS® provides contrast and smoothing algorithms to facilitate
automatic edge detection. Once a sequence of images is digitized into DIAS®, the user can then
generate a centroid (cell center) path, which appears as a spatial sequence of dots attached by thin lines,
or a perimeter plot, which appears as a spatial sequence of overlapping cell perimeters. The user can
also generate difference pictures, which are really double images containing the overlapped perimeters
of 2 sequential images in which expansion zones (areas only in the later perimeter) and contraction
zones (areas only in the earlier perimeter) are coded. This provides the user with a unique view of
cellular dynamics. Once the images are digitized, the user can then direct DIAS® to compute
parameters based on the dynamics of the cell centroid, such as velocity, direction change and
persistence, or on the dynamic changes in contour, such as width, length, area, perimeter, roundness,
convexity, concavity, etc. A particular region of a cell can also be windowed and individually
analyzed, such as a pseudopod, lamellopod, or uropod. The quantitative capabilities of DIAS® are quite
large, and can only be appreciated by actually using the system. If there is a unique computation which
the user desires, the user can use some of the options in DIAS® to generate customized parameters, and,
if necessary, can interact with our staff to accomplish this. If desired, the user can generate computer
movies of the cell centroid, the cell perimeter or the differenced image, which can be viewed at any
speed, or transferred back to videotape for presentation. The quantitative data can be viewed or printed
in tabular or graphic form, and DIAS® includes a number of styles for publication-ready presentation.
Although DIAS® has been fine-tuned to digitize images, generate unique dynamic representations
of the digitized image and quantitate many aspects of cell motility and the dynamic changes in cell
shape, there are certain aspects of motion analysis which the user must be acutely aware of if the user
wishes to obtain full and effective use of the system. Some of these points are considered in the
remaining portions of this Introduction.

The Biological Preparation
There are many options which the user can employ to obtain analyzable recordings. The most
important thing to keep in mind is that if you can follow the object in your recording, you can use
DIAS® to analyze it. For instance, if you record the behavior of a cell in tissue or in cell aggregates and
can discriminate some or all of its perimeter, you can hand outline its behavior and obtain meaningful
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data. On the other hand, if you are interested in the refined behavior of a pseudopod which is less than
3 um in length, you may need to isolate that cell from other cells so that the perimeter is intact, and fine
tune the illumination in your microscope in order to obtain the best outline of the cell without affecting
cell behavior as a result of light or heat.
When analyzing cell motility in vitro, one must test whether the conditions employed support
continued motile behavior. For instance, many cells will stop moving when constantly illuminated or
when starved for oxygen. Some cells will not move because they can not properly adhere to the
substratum. One must, therefore, be conscious of temperature, light, substratum, composition of the
medium and genesis of microenvironments. In other words, the biology of the system being analyzed
is the most important initial aspect of a motility experiment. Optimize your system. Be careful of the
composition of the supporting medium. Test motility on different substrates. Make sure your cell is not
glued to the substratum, and make sure the motility you are measuring is not due to flotation. Make sure
your cell is not being pushed backwards by an extending pseudopod because the cell body is
inadequately attached to the substratum. Check the temperature of your preparation on the microscope
stage. Make sure your preparation is not losing motile activity with time because it is overheating.
Check for pH. Check for light sensitivity. If necessary, use perfusion chambers, which will inhibit the
genesis of microenvironments, provide continuous nourishment and help maintain the proper temperature.

Lighting, Magnification and Recording
As noted, DIAS® has both a manual and automatic mode for digitizing the perimeters of cells.
The manual mode is slower than the automated mode, but provides greater detail and more refined
perimeters. In cases of cell crowding and overlap, or in cases in which a cell is imbedded in tissue or is
on top of a monolayer, the manual mode is in many cases necessary. Remember that when one is
following the path of a cell in a complex setting, one can interpret the perimeter even when it is not
clearly exhibited if one has viewed the cell perimeter in previous and subsequent frames. The work
which would be necessary for a computer program to achieve the same level of discrimination is
beyond the size and speed of almost any platform. However, manual digitization is not really that slow
when one considers the time it takes for hand tracing in relation to the total time of the experiment.
In some cases, flat cells like fibroblasts may not provide a distinct enough, or contrasted, edge
in relation to the substratum, and will require hand digitization. In addition, certain kinds of lighting
such as phase contrast will generate a black/white edge on one side of a cell, and a white/black edge on
the other side. In addition, the phase halo may interfere with automatic digitization. The best way to
test whether automatic digitization is feasible is to simply test your lighting conditions, and play with
the light source, magnification, type of optics and condenser. In many cases, a high contrast image
which loses intracellular detail provides the best edges for automatic digitization of the cell perimeter.
If your project requires that large numbers of cells are analyzed, and you are not that interested in high
resolution detail of the perimeter, then high contrast, low magnification conditions can easily be
developed for automated digitization. Since DIAS® will analyze in parallel as many as 50 cells moving
on a substratum, magnification must be set so that the necessary number of cells are contained within
the field recorded.
Although recording on half inch tape provides an adequate image, three-quarter inch tape and
direct digital recording provides higher resolution. Since many cameras provide the user with the
capacity to process the image as it is recorded, the user should experiment with the system employed,
especially if a high contrast image is needed for automatic digitization. It should also be kept in mind
that under certain circumstances, the video signal from the camera can be hooked directly into the
framegrabber. However, possessing a recording of your preparation has a number of advantages and
provides a backup in case a computer problem arises.
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Adequately utilizing the Quantization and Dynamic Representation Provided by
DIAS®
The quantitative capabilities of the original DMS and the new DIAS® programs have had a
history of underutilization. The user must realize that once your cells have been digitized into the
DIAS® database, you can apply virtually every capability of the program in your analysis of that cell. If
you originally only need a velocity or roundness measurement with time, compute some of the other
parameters at your disposal. You may very well be surprised to find that an unexpected parameter
provides new insights into the behavioral phenotypes that you are defining. This is especially true
when you are comparing a normal and neoplastic cell, or a wild type and mutant cell.
In addition, generate some of the dynamic representations provided by DIAS®. Play them at
different speeds. Sometimes, speeding-up a movie exposes cyclic behaviors missed in slow view (real
time) movies. Generate a dynamic difference picture. It will give you insight into the expansion and
contraction zones of your motile cell. These informative movies can then be videorecorded and used in
presentations and seminars.

Problems of Three Dimensionality
We tend to view a cell as a 2 dimensional object primarily because in conventional microscopy
we view the cell from the top or bottom, and tend to perceive behavior in a single focal plane.
Remember that your cell is, in fact, 3 dimensional and may not always be in contact with the substratum
at all points on the cell surface opposing the substratum. Unfortunately, DIAS® is a two dimensional
system. Usually, analyses are performed at a relatively constant focal plane at a set distance from the
substratum. Therefore, DIAS® provides no direct information on z-axis changes. Contour changes and
motility parameters are all limited to the x,y-axes. In most cases, x,y-axis information is useful and
provides valuable information concerning a behavioral phenotype, but the user must remember that
without z-axis information, the description may be incomplete. There are two indicators of z-axis
behavior which the user can assess. First, if the area of an image changes significantly, and, especially,
if it cycles, there may be a strong z-axis component to the behavior of the cell of interest. Second, if
parts of the cell move out of the focal plane and, therefore, become blurred, it is probably due to
behavior in the z-axis. The user can adjust the focal plane to continue monitoring that portion of the
cell. In most cases, z-axis information would add to the description of phenotype, but is not essential
for extracting relevant and useful 2D data.

Time to Begin
With the above points in mind, the best way to begin using DIAS® is to simply turn it on and
become acquainted. Once you achieve initial familiarity with the system, take one of your videotapes
and move through the manual. This initial test of the system will help you optimize your conditions for
obtaining videotapes for analysis. If you experience problems, feel free to contact us at Solltech. We
will be more than happy to work with you in the initial stages of learning the system.
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II
Installation
It does not require a computer expert to use DIAS®. However,
we do recommend that if you are a new user, you begin by
mastering the basics of your Macintosh® computer. Tutorials
and manuals included with your Macintosh® will help you to
become better acquainted with how a Macintosh® computer
works. Before continuing, please be sure you have familiarized
yourself with the basic terminology of the Macintosh® Operating
System, how to use a mouse, etc.

The Sentinel protective device
The DIAS® system includes three separate parts; the
DIAS® manual, the DIAS® program diskette, and the Sentinel®
protective cable (Fig 2.1). The SentinelEve3® cable must be
connected between your keyboard and the cable connecting the
keyboard to your Macintosh® CPU in order for the DIAS®
software to start up and run. If you try to start or run DIAS®
without attaching the SentinelEve3® device, you will be asked to
check the connection and try again (Fig 2.2). After hooking up
the SentinelEve3® for the first time, the computer must be restarted.
With the SentinelEve3® attached, you are still able to back up
both the DIAS® program as well as all of your program files. The
SentinelEve3® is only designed to keep multiple copies from
being run on other computers, simultaneously.

Fig 2.1
A photograph of the
SentinelEve3®.

Fig 2.2 The message you will see if you
start or run DIAS ® without the
SentinelEve3® attached.

Note: Any text, graphics, or QuickTime® files
which are created in DIAS® may be opened and
used by other programs, without the need for the
SentinelEve3®.

System settings
When running DIAS®, you need to have your monitor
control panel set for at least 256 colors, but the 'Thousands' or
'Millions' settings will give you both better (visually) and faster
(screen refresh) results. Also, DIAS® is set to run at a minimum
of 12 Mb of RAM, however, it is advisable that you run it at
24Mb if possible. In both cases, this refers to the amount of
RAM memory available after subtracting the amounts used by
the System, and any other currently running programs, not to the
total system memory. In order to change the amount of memory
allocated to DIAS®, single-click on the DIAS 3.0 program icon
(to highlight it) and then, while in the Finder, select Get Info
from under the File menu (or type'I'). Doing so will bring up

Fig 2.3 The DIAS® program 'Info' box.
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Figure 2.4. The DIAS disk.

a dialog box similar to the one shown in Figure 2.3. To increase
the memory allocation to the DIAS® program, highlight and
change the number listed in the 'Preferred size' box in the lower
right hand corner of the dialog box. We recommend setting it
within the range of 12000 to 24000, although you can increase it
even higher if you have enough memory.
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Figure 2.5. The DIAS folder.

To install DIAS®, insert the DIAS® disk into the floppy
drive of your computer (Fig. 2.4). Double-click on the icon of
the floppy disk to open it. You will see a folder called "DIAS"
(Fig. 2.5). Drag (copy) the DIAS folder to your hard drive.
The folder contains the DIAS® program (Fig. 2.6).
You can begin using DIAS® by double-clicking it's icon.
This will take you into the program and load the DIAS® menus
into the menubar.

Descriptions of DIAS® icons

Figure 2.6. The DIAS® program.

Figure 2.7. Examples of movie file icons.

Figure 2.8. An example of a path file
icon.

Figure 2.9. An example of a text file
icon.

The following is a list of the different types of icons you
may generate in DIAS®, what they represent, and where you can
find more information about them.
Movie files (Fig. 2.7). These icons represent movies,
either DIAS® or QuickTime® movies, which have been either
captured or processed by DIAS® (Chapters III and XVI).
QuickTime® movie file icons will have a small 'QT' in the upper
right hand corner of the icon.
Path file (Fig. 2.8). This icon is for path files and when
double clicked, opens up the ViewPaths and EditPaths sections
of DIAS® (Chapter VI).
Text file (Fig. 2.9). This icon can represent any type of
text file, but will primarily be used when you save summaries of
computed output.
Database file (Fig. 2.10). This icon represents a
specifically formatted DIAS® database text file. Double-clicking
on this icon will open up the Use database section of the
program (Chapter X).
Graph file (Fig. 2.11). This icon represents graphs created
while in either the Compute parameters or Use database
sections. Double-clicking on this icon will open up the Graphics
Manager (Chapter IX).

How to proceed
In order to analyze an experiment in DIAS®, you must
first have made a digital recording of that experiment (Chapters
III and XVI). Once you have done so, you should proceed to
tracing the objects of interest in the movie, and making paths of
those objects (Chapter IV). With paths made, you may analyze
2.2
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the motility and dynamic morphology of the traced objects using
graphing and numeric methods (Chapter VIII), by creating and
studying dynamic movies of movement and shape change
(Chapter VI), or by studying static images of changing shape
(Chapter XI).
Note: Throughout the DIAS® program, it is always
important to read the title bar of the open window,
as it will often instruct you on how to proceed
during a current step.
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III
Making Movies for Analysis
What types of movies can DIAS® use?
DIAS® is designed to analyze how cells move and change
shape over time. In order to do so, it is necessary to translate
analog movies (standard video) into a digital format which DIAS®
can open, read and analyze. DIAS® can analyze movies in two
types of digital formats, QuickTime® movies and its own DIAS®
movie format.
DIAS® analyzes and outlines movies in its own format
significantly faster than it can QuickTime® movies of the same
window size and number of frames. As movies increase in size,
the difference in speed will grow geometrically. This is due to
how QuickTime® movie files are stored. They store a significant
amount of information in the resource fork of the file. While it is
not important for you to understand this, it is important that you
understand that this is the same section of the file which DIAS®
uses to store traces and slots (Chapter IV).
If you already have movies saved as QuickTime® files, it
is easy to convert them to DIAS® movies. That process, and the
various options involved will be described in the next section of
this chapter.
DIAS® will also create movies in its own format using
some QuickTime® Framegrabbers. That process will be covered
in Chapter XVI.

Saving and converting between movie types
The following process will be used for a number of
purposes. Use the following process if you wish to change a
DIAS® movie to the QuickTime® format for use
in another program. These are also the steps to
use if you need to edit the size, shape or image
quality of a movie file, or if you wish to convert
a QuickTime® movie file to the DIAS® format
for use in outlining. In any of the above cases,
the process will be similar.
In order to convert between formats, you
must first start the DIAS® program, and open the
applicable movie, using the Open command,
from under the File menu.
With the movie open and on the desktop,
select Save from under the File menu. Doing so
will bring up the 'Set Frame Parameter' dialog box (Fig. 3.1).
This is the first of many dialog boxes which will give you

Figure 3.1. The 'Set Frame Parameter'
dialog box.
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Figure 3.2. The 'Multiprocess?' dialog
box.
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extensive control over, and the ability to change and process,
your movie.
Many of the options in the Parameter dialog box are selfevident. You can select to save only a subsection of the total
number of frames in your movie (using 'First frame to save' and
'Last frame'). You can even skip among the frames within the
subset (using 'Frame increment'). There are also several methods
of magnifying the movie, some of which may be less self evident.
By making entries into the 'Magnification' section of the
'Parameter' dialog box, you can enlarge or shrink your movie. To
enlarge or reduce the movie uniformly, simply enter a single
number, followed by an 'x'. For instance, entering '2x' will
double the size of the movie, and entering '.5x' will reduce its size
by 50%. You can also use this section of the dialog box to
change the relative sizing of the movie. Entering '1 x 1.5' will
stretch the height of the movie window to 150% of the original
size, while leaving the width unchanged.
You may also use the 'Center on larger window' command
in the dialog box to change the overall window size of the movie,
while leaving the actual image size intact. If you are putting
together a video presentation, and some of the movie clips vary
in size, you may wish to size and center them all to the same
window size. For instance, if you are putting together a
presentation, and most of the movies are 640 x 480 resolution,
but your current movie is only 512 x 400, you can either use the
above described method to increase the image size of the movie,
using 'Magnification', by entering '1.25 x 1.2' which will distort
your movie image, or you can enter '1.25 * 1.2' in the 'Center on
larger window' section. Using the centering command, instead
of the magnification command, adds a white border around the
original movie, leaving the original movie image intact in size
and relative resolution, but changing the size of the encompassing
movie window. This is helpful when creating movies that will be
combined in other applications, such as MoviePlayer or Premiere,
as those programs will not center movies of differing sizes, and
may actually change the size and relative resolution of the movie.
Besides resizing the movie image, you can also rotate it
using either the 'Rotate' command, which allows you to enter a
degree of rotation, or the 'Mirror' command, which allows you to
mirror the image along either the 'hor'izontal or 'ver'tical planes.
Finally, the 'Parameter' dialog box allows you to 'Tint' the
greyscale images using either blac'k', 'r'ed, 'g'reen, 'b'lue, 'o'range,
or 'y'ellow.
Once you have made all of your choices in the 'Parameters'
dialog box and clicked on 'OK', you will then be asked whether
you wish to 'Multiprocess?' (Fig. 3.2). Multiprocessing will be
covered later, in Chapter XVII. If you wish to image process
your movie at this time, proceed to that part of the manual for
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more information. Otherwise, click 'No'.
You will now be given the opportunity to 'Select (a) clip
rectangle?' (Fig. 3.3). Answering 'Yes' will allow you to select a
subsection of the window size for saving. Doing so will decrease
the movie window size, as well as decreasing the amount of
memory which the movie will take up on your hard drive. If you
answer 'No', the movie will be saved at the same size. If you
select 'Yes', the title bar of the movie window will instruct you to
select a clip rectangle. At this time, you may either select an area
by freehand, simply using the mouse to draw a bounding box
around the area of choice, or you may select an area of exact size,
by typing 'f' for frame size.
Typing 'f' brings up a dialog box which will ask you to
'Set (the) Window Size' (Fig. 3.4). Type in an exact size for your
bounding box and click 'OK'. You will then see a moving
bounding box of that size, which you may use to select a subsection
of your movie image window. You may want to use this option
if you wish all of your movies to be the same, smaller, size for
later presentation.
Upon making a movie area selection, you will be asked to
name your new movie, using a standard Macintosh Save dialog
box. Do not attempt to rename the movie with the current name,
as that will cause system problems. After picking a new name,
you will be presented with a dialog box giving you different
types of 'Movie (file) format(s):' for your final movie (Fig. 3.5).
The 'BIN' format should only be selected if you wish to use the
saved movie with an older version of DIAS®. The 'DIAS' format
should be selected if you wish to use the movie for analysis, and
particularly if you wish to trace on the movie. The
'QuickTime®' format would be appropriate if you wish to use the
movie as part of a presentation, and wish to use it, or edit it, with
other programs such as MoviePlayer® or Premiere®. The 'PICT
Stack' format is useful if you wish to break up your movie into
individual PICT images, for use in a paper, or other static
presentations. The 'ECON' format should only be used with
movies which already contain traces. This format saves only the
areas of the image within the traced regions. Discarding the
background of the image.

Figure 3.3. The 'Select (a) clip rectangle?'
dialog box.

Figure 3.4. The 'Set Window Size' dialog
box.

Figure 3.5. The 'Movie Format:' dialog
box.

Note: If you select the QuickTime® format, you
will be presented with a standard QuickTime®
Compression Dialog box. We will not attempt to
discuss those options in this manual, as it is an
Apple designed selection, and well beyond the
scope of this manual.
After selecting a 'Movie format:' and selecting 'OK', you
will then be asked if you wish to compress the movie (Fig. 3.6).

Figure 3.6. The 'Compress movie:' dialog
box.
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Doing so will shrink the amount of memory your movie will take
on your hard drive. However, doing so will also convert your
movie to greyscale, removing all color or tint.
Once you have made all of your selections, you will see a
new window open up, and your movie will be saved in that new
window, several groups of frames at a time.

Using a stack of PICT images

Figure 3.7. The 'Open as stack movie?'
dialog box.
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A DIAS® movie may also be created by converting a
stack of sequentially numbered 'PICT' images. 'PICT' stack
conversion is designed for those people who use NIH 'Image', or
other, similar programs, and a frame grabber to grab individually
numbered frames. The frames of the stack must be stored in a
separate folder, and numbered sequentially, using no letters or
punctuation (i.e., 1,2,3; not 01, 02, 03). The frames can then be
converted into a movie by opening the first 'PICT' image in
DIAS®. If the file is in a folder as described above, when
opening the first image, a dialog box will ask whether you wish
to 'Open as a stack movie?' (Fig. 3.7). If you click on 'Yes', the
images will be opened as a movie. You should then save the
movie, following the steps designed above. If you click on 'No'
in the dialog box, the file will open as a simple PICT image.
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IV
Tracing Cells and Making Paths
Why Trace Cells?
For DIAS ® to analyze the motility and dynamic
morphology of the objects in your movie, those objects must be
outlined and identified within DIAS®. DIAS® provides two
automated, Auto Trace by Threshold and Auto Trace DIC,
and two manual, Trace on Movie and Trace on Movie with
Splines, methods for tracing/outlining your cells (Fig. 4.1).
Both of the automatic tracing methods, which will be
covered in more depth later in this chapter, include various
controls to allow for the best outlines possible. They both utilize
powerful algorithms for fast and easy outlining. However, there
will be circumstances when the automatic outliners are not enough,
and complete, manual control is needed.
One instance may be when the lighting and/or resolution
of the images in the movie are poor or uneven, making accurate,
automatic tracing difficult. Another, less obvious instance, is
when analyzing large numbers of cells which collide or cross
paths. While the automatic outliners may work well for these
types of movie images, constructing paths may be extremely
difficult because of collisions and complex path crossings. If this
is the case, manually outlining individual cells, through the
length of the movie, and placing the traces of individual cells in
separate slots (explained below), may be the best answer.
In any case, because outlining, using any of the methods,
is so important to performing an accurate analysis, it is important
that you understand all of the capabilities of the various methods.

Figure 4.1 The DIAS menu.

Note: You will have to use the Trace on Movie
command in order to create a scale factor for your
movie, unless your are only interested in relative
movement and shape change, or know the scale
factor from other experiments.

What are Trace Slots?
Even though outlining cells is essential to your work with
DIAS , it is also important that those tracings do not permanently
change or mark over the original movie images. DIAS® saves
traces as a separate part of your movie, in the resource fork of the
movie file. Because there will be times, as described above,
when there are multiple traces needed for the same file, DIAS®
allows you to save up to 61 different sets of tracings for each
movie. Each tracing is a transparent overlay for each individual
®
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Figure 4.2 The 'Set Trace Slot' dialog
box.

frame of your movie file. Selecting a specific trace slot displays,
and allows you to edit, the traces saved in that slot only. So, it is
important that a trace slot is selected before you begin tracing on
your movie file. The default slot is always slot '1', and it may be
that you never need to change that selection.
If you do need to select a different slot in order to trace a
separate object, try a different method of tracing, or for whatever
reason, simply select Current Trace Slot: from under the DIAS
menu. Doing so will bring up the 'Set Trace Slot' dialog box (Fig.
4.2). You may select trace slots 1 thru 9, a thru z, and capital A
thru Z. Once you have selected a slot, or elected the default, you
are ready to begin tracing.
Note: The menu will always display the current
slot for the open movie.
Note: You may select to display two or more
slots by listing them in the dialog box, separated
by commas. In fact, it is often helpful to do so
when tracing images crowded with multiple
objects. However, you may only trace or edit the
traces in one slot at a time. It will be the slot listed
first, and it will be the only one whose outlines are
not red.

Auto Trace by Threshold

Figure 4.3. The QuickTime® time-base
verification dialog box.

Figure 4.4. The 'Set Frame Range' dialog
box.
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Before selecting any of the trace functions, you must
have first opened either a DIAS® or QuickTime® movie. If you
are opening a QuickTime® movie for the first time, DIAS® will
ask you to verify the movie's frame rate. A dialog box will
appear on screen, asking for a 'Unit of time' and 'Frame rate' (Fig.
4.3). 'Unit of time' refers to the time units which will be used on
all graphs and charts. DIAS® recognizes 'us' (microseconds),
'ms' (milliseconds), 'sec', 'min', 'hr', and 'day'. Do not use periods
'.' when typing in the time unit. 'Frame rate' refers to the number
of frames captured during a single passage of the time unit. The
example in Figure 4.3 gives the current movie a frame rate of 5
frames per second. You could also enter this as 300 frames per
minute. If you make a mistake, you can change the time unit and
rate later by editing the file's header.
After the movie has opened on the desktop, you may then
select Auto Trace by Threshold from the DIAS menu. Doing
so will bring up a dialog box which will ask you the range of
frames which you wish to trace (Fig. 4.4). You may pick any
range you wish. You may outline different sections of the same
movie, using different settings. It is to theses frames that the
automatic tracing algorithms will be applied. Do not worry if
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some of the frames within the range do not trace well. All of the
traces made during the automatic processes may be edited later
using the Trace on Movie command.
After you have selected a frame range, the title bar of the
movie window will instruct you to select an area to outline.
Again, in similar fashion to the frame range, your selection tells
DIAS® if you wish to select a specific region of interest to
outline, instead of the entire movie window. This is occasionally
useful if the cell of interest only moves around within a small
area of the total window, or if there are debris or objects in the
perimeter of the image which you do
not wish to outline. Cutting those
objects out of the outlining process
now, means that you will have to do
less editing of the traces and/or path
files, later. To select an area, use the
mouse to draw a rectangle around that
area. If you wish to trace the entire
movie window, click the return key.
At this point, the 'Auto Trace
by Threshold' dialog box will open on
the desktop (Fig. 4.5). There are several
entries which you may make in this
dialog box. All of them designed to
make automatic outlining easier.
Threshold
Greyscale images run from
black (0), to white (255). The number
which you enter here determines at
what cutoff level to outline above.
While you do not see this on the screen,
DIAS® will convert everything above that number to white, and
everything below that number to black. The black areas are then
outlined. In the example above, any objects which have a
greyscale level above 128 will be outlined. Changing these
numbers will change the areas being outlined. Assuming that
your cells are dark on a lighter background, increasing these
numbers will shrink or remove outlines, while lowering the
numbers will include a greater area of outline.
Min and Max Pixels
The pixels that these commands are referring to are the
number of pixels making up the outline of the object(s). Use the
'Min' number to eliminate small debris from the outline. Use the
'Max' number to eliminate large areas, for instance cover slip
edges, from the tracings.
Dilate and Erode
'Dilate' provides a powerful tool for repairing objects that
have gaps in their outlines which would normally prevent the

Figure 4.5. The 'Auto Trace by Threshold'
dialog box.
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A

B

Figure 4.5. Two objects needing dilation
to close the boundary

A

B

Figure 4.6. The process of dilation

outline from being closed, or for objects with small, thin
extensions.
In figure 4.5, the center of the image of object A was so
diffuse in one section as to appear transparent. Object A therefore,
digitized as two objects. The result of a 'dilation' of 1 is shown in
Figure 4.6. Note that for each pixel, the four horizontal and
vertical neighbors are added. The result is then outlined.
Therefore, only the outermost portions of the dilated object are
used. Higher dilations simply repeat this process the desired
number of times. Dilations of 3 or higher significantly distort the
shape of the object. The default is no dilation (0).
The above dilation process ‘fattens’ the object by the
amount of 'dilation'. Erosion ‘thins’ the object the required
number of times so that the original size is approximately
preserved (Fig. 4.7). One round of erosion moves each boundary
pixel inward a distance of one pixel. As a rule, if the object was
'dilated' n times, the 'erosion' should be n or n-1. High erosion
numbers can create bizarre results.
Smooth Image and Smooth Outline
Both of these commands allow you to make subtle changes
to the outlines of your cells. Occasionally, because of sharp
contrast or lighting, the edges of an outline will appear jagged. In
order to smooth those outlines, you can smooth either the image
or the outlines directly any number of times.
Note: Any smoothing which you perform here is
temporary, and only effects the outlining process,
and not the image itself.

A
Figure 4.7. The erosion process
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B
Resolution
Resolution refers to the resolution of the outlines, and not
the original image. Changes in these selections will effect how
tightly or loosely the outlines adhere to fine detail of the objects.
Invert image
In order to automatically outline the cell(s) in your movie,
they should be uniformly dark on a light and even background. If
they are not, clicking on 'Invert image' flips the image from light
cells on a dark background, to dark cells on a light background,
making the threshold process work correctly. Again, this does
not permanently effect the movie image.
Remove halos
Clicking on this option attempts to remove the doubletraced halos which occasionally occur in some types of
microscopy.
Save and Load Setting
Once you have optimized all of your settings, clicking on
the 'Save Setting' button brings up a standard Macintosh® Save
dialog box, which will allow you to name and save a formatted
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text file containing the settings which you have entered. Once
you have done this, you can click on the 'Load Setting' dialog box
to load those settings when working on other movies.
Note: These capabilities will appear in many
dialog boxes throughout the program.
Preview, <<, and >>
After you have made any changes in the above options,
clicking on the 'Preview' button shows the effects the changes
have made on your outlines.
If you think that the lighting or quality of your movie
images changes significantly over time, you can single frame
step through your movie, seeing the effects of your options on
each frame, before beginning the actual outlining process.
Note: None of the outlines you see during the
'Preview' or single frame advance process are
permanent. It is not until you click on 'Start' that
all of the frames are outlined.
After clicking on 'Start', you will be able to see DIAS® as
it outlines each frame. You may stop the process early by
pressing and holding the Apple and '.' keys simultaneously, until
the process stops. Remember, the outlines do not have to be
perfect at this point, as you can edit them with ease using the
Trace on Movie command.

Auto Trace DIC
Auto Trace DIC is another automatic outlining method
offered by the DIAS® program. This method uses a pixel
complexity method for finding the outlines of in-focus cells.
While it may be used for fields of cells, because of the methods it
uses for targeting cells, it is used primarily for movies of single
cells. When you first select this command, you will be asked for
a range of cells, and to select an area of the image window, just as
you were with Auto Trace by Threshold.
Once the dialog box opens, you will notice that there are
four basic controls to Auto Trace DIC (Fig. 4.8) All four of the
options are percentage based, so numbers between 1 and 100
should be entered for each.
Sensitivity
This control refers to the sensitivity of the method in
looking for changes in pixel complexity around the cell. The
more you increase sensitivity, the tighter the outline will generally
adhere to the cell boundary.
Noise removal

Fig. 4.8. The 'Auto Trace DIC' dialog
box.
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This command is similar to smoothing in the case of the
automatic threshold outliner. As you increase this number, small
variations will be lessened.
Connectivity
Variations in this number will effect the attachment of
small, barely attached objects.
Outline Size
This command is similar to erode command, with greater
variability. Varying this number will effect the general tightness
of the outline.
The other options in this dialog box are identical to those
already covered under the Auto Trace by Threshold command.

Trace on Movie

4.6

Some of the various reasons for hand tracing have been
covered earlier in this chapter. Two other important reasons will
be covered here as well. First of all, the Trace on Movie
command allows you to edit the automatic traces made using
either of the previously described methods. Opening a movie, as
described earlier, and selecting Trace on Movie, will allow you
to erase whole traces, or parts of outlines, making it easy to make
simple corrections to the previously saved outlines. Most
importantly, it is while under this command that you may set the
scale for your movie. Doing so will allow you to compare the
motility and morphology measurements between various cells
and experiments. Measuring and setting scales will be covered
later in this section.
In order to trace/outline manually on your movie, simply
open it on the desktop and select Trace on Movie. Because
everything at this point is manual, there is no need to select a
range of frames, you may stop and skip around frames as you
wish. There is no need to select an area, as you will do so by
drawing only in the areas that you wish.
The Trace on Movie command gives you a cross-hair
pointer which you may use to draw freehand on top of your
movie frame image. To outline a cell or object, simply click and
draw around the desired object, making sure that the outline is
closed, without gaps in the outline. It is essential that an outline
is closed. If it is not, that object will not be included in future
paths and analysis. While in either of the manual trace modes, if
an outline is not closed, DIAS® will warn you of that fact, giving
you the opportunity to make a correction now, instead of waiting
until you discover the problem later, while making paths.
While in the Trace on Movie command, you will notice
that the title bar of the movie list the usual file name and frame
number information. However, it also lists 'Type ? for Help'.
This will appear in both of the manual trace title bars. For a list
of additional control and key commands appropriate for the
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current trace method, type '?'. Doing so will bring
up a window listing those options (fig 4.9).
Most of the options make your manual tracing
experience easier, and are self-explanatory. The
one option which is more involved, and necessary
for most users is the 'measure/set scale factor'
command, accessed by typing 's'.
In order to make accurate and comparable
calculations, a scale factor must be entered into the
DIAS® header for each movie. To enter a scale, you
must have recorded something of known length at
some time during the making of the movie (see
Chapter I). Proceed to the frame of the movie which
contains the measurable item by typing 'g'. This will
bring up a dialog box asking for the desired frame
number. Enter that frame number and click 'OK'.
You are now ready to type 's' and measure/set your scale.
When you first select the measure scale factor command,
a dialog box will list the current scale factor, and that you may
change the scale factor by typing '?' in the top line of the dialog
box (Fig. 4.10). To change the scale factor, type '?' in the top line.
The second part of the dialog box will allow you to enter the
increment of measurement which you wish to use. DIAS®
recognizes 'um', 'mm', 'cm', 'm', 'in', and 'ft' as units of
measurement. When typing in a unit of measurement, do not use
a period '.'.
After you have typed a '?' in the top line of the dialog box,
and a unit of measurement in the second, click 'OK'. At this time,
the title bar of the movie window will ask you to draw a line of
know length. After you draw the line, by clicking and dragging
the mouse a known length, a dialog box will ask you to enter the
'Length of (the) line', and to verify the 'Unit' of measurement
which you wish to use (Fig 4.11). After you have entered the
correct information and clicked 'OK', you are done.
Because of the flexible nature of the both of the manual
tracing commands, you may work on as many or few frames at a
time as you wish. You may always come back and reedit or
finish tracing later.

Fig. 4.9.
screen.

The Trace on Movie help

Fig. 4.10. The 'Calibrate Scale' dialog
box.

Fig. 4.11. The 'Set Line Standard' dialog
box.

Trace on Movie with Splines
Trace on Movie with Splines is very similar to the
Trace on Movie Command. It is designed for manually tracing
cells. However, in this command, instead of freehand drawing
lines and curves, you use the mouse to place points around the
curves of the objects in which you are interested, and then use
DIAS® to finish out those curves. As in the other manual tracing
command, there is a help list available by typing '?' (Fig. 4.12).
You may also use this command to measure/set your scale factor.
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Again, most of these key commands are self
explanatory, and will not be covered here.

Show Tracing
This command allows you to display or remove
the image of the traces from the foremost movie file.
This command does not permanently effect the trace
files.

Clear Tracing
This command allows you to erase, or clear, all of
the traces from your current trace slot. After selecting
this command, you will be asked for a range of
frames to clear.
Fig. 4.12. The 'Trace on Movie with
Splines' help list.

Note: Instead of clearing traces, you can always
change to a different trace slot. That way, you do
not lose your work if you are unsure as to whether
you will want to use it again in the future.

Backup Tracing
This command allows you to backup your traces to a
separate file. This is a good safety feature, and should be used
often, especially if you are doing a great deal of time-consuming
manual tracing. This command backs up the traces in all of the
slots in the current movie.
After selecting this command, you will be prompted for
the name of the backup file, using a standard Macintosh save
dialog box.
The file created with this command is only useful when
paired with the Restore Tracing command.

Restore Tracing

Fig. 4.13. The 'Restore Tracing' dialog
box.
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This command allows you to restore a set of traces to a
movie, assuming that you had backed them up, using the Backup
Tracing command.
You should have the movie open which you wish to
restore traces to, before selecting this command. After doing so,
and selecting the command, you will be prompted for the backup
file you wish to use. When you have selected the backup file, the
'Restore Tracing' dialog box will open (Fig. 4.13). In this dialog,
you must enter which slot from the backup file you with to use
(the 'Source slot'), which frame you wish to start with from the
source file (the 'First src frame'), which slot you wish to place the
traces into in the current movie ('Target slot'), and where in the
current movie you wish to start and finish the traces.
The variation in the start frames between the source file
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and the target movie allows you to copy traces from one movie,
to a much longer version of the same, without having to replicate
all of the actual tracings. In this way, you can merge short
sections of traces into a longer movie, or add frames to the
beginning or end of a shorter movie.

Save Tracing as Movie
This command allows you to make a movie of just the
outlines of your objects. This is occasionally useful for
presentations. Similar types of movies may be created using the
commands under the ViewPaths menu (Chapter VI).

Merge Tracing into Movie
This is another command which is useful for some types
of presentations. If you wish to show a colleague what you have
outlined, but they do not have DIAS®, you can Merge the
Tracing into Movie, save the movie as a QuickTime® file, and
let them view both your original data, as well as your traces.

Join Stage Movement
This command is designed to remove the jumps in cells
and data which occur when slides or stages are moved during an
experiment. DIAS® may determine that there are in fact two
different objects or cells, the second one appearing after the jump
while making paths because of large, sudden movements. This
command allows you to take the jump out of the movie, thus
eliminating the problem.
DIAS® has several commands designed to help with the
same problem. There are the two join path commands under the
EditPaths menu (Chapter VI). However, these commands may
slightly distort the motility for the frame where the jump occurs.
This is the case, because it cannot always accurately discount the
movement of the cell from the movement of the stage. Under the
Movie menu is the Stabilize Movie command. This command is
very similar to Join Stage Movement feature, but designed for
more continuous movement, as seen in poor videos, or in
equipment with poor tracking. Moreover, this command can
only be used on raw movies. It will erase any traces in a movie.
The Join Stage Movement command is the only one that
allows you to subtract the movement of the stage only, and still
retain all of your traces.
If you decide to use the Join Stage Movement command,
you must first have a movie open and on the desktop. Selecting
the command will bring up the standard Frame Range dialog
box. Since this command will create a new, stand alone movie,
make sure to include all of the movie which you wish to analyze.
After selecting the desired frame range, a dialog box will ask you
4.9
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Fig. 4.14. The 'Frame Number' dialog
box.

to 'List (the) frames AFTER WHICH the stage moves' (Fig 4.14).
Enter here the first shifted frame number.
After you have done so and clicked 'OK', you will be
taken to the frame previous to the shift, and the title bar of the
movie will instruct you to select a known object before the stage
shift. You should click the mouse on a stationary object. Use
any spot or object which remains stationary throughout the
current section of the movie. If you select the moving cell itself,
the correction in stage shift will also subtract any motility for the
cell between those two frames.
After choosing and clicking on your reference point, the
movie will advance to the next frame, and you will again be
instructed to click on the same point. Following this will be save
and movie type dialog boxes, identical to those described in the
previous chapter. After those dialog boxes, you will be asked if
you wish 'Economize' the new movie. Economizing was also
covered in the last chapter, but in essence is the process of
removing all of the background in the movie, and leaving only
the outlined areas.
Once you have made your choices, you will be asked
which trace slots to preserve. You should preserve any slots in
which you currently have traces.
Upon making this final selection, a new window will
appear, and you will see the new frames saved. Notice that the
new window is larger than the old movie window. This is to
accommodate the new larger area of analysis, caused by the
inclusion of the shifted area. When the movie gets to the shifted
frame, you should see how the rest of the movie is shifted in
response to your target points.
You may now proceed to further tracing, or to making
paths.

Make Path From Trace

4.10

Tracings importance was partially covered at the beginning
of this chapter. It was explained that accurate traces provide
accurate morphometric information motility analysis. While the
traces are all that is needed for the morphometric analysis, before
motility may be measured, paths must be made for each of the
cell/objects you wish to analyze.
Without making accurate paths, DIAS® won't be able to
asses which cells are linked, and how to calculate any of the
motility based parameters. The Make Path From Trace
command is the first part of the path creation process.
Before beginning the path making process, make sure
that the desired movie is open and on the desktop, and that the
desired trace slot is selected.
After selecting the movie and trace slot, and clicking on
Make Path From Trace from under the DIAS menu, the 'Make
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Paths From Traces' dialog box will open (Fig 4.15).
The first three items in the dialog box are self explanatory
and will not be covered here.
'Max movement/frame'
helps determine how objects are
connected. When an object is
detected, the X and Y
coordinates of the pixels are
averaged, respectively, to
calculate the centroid of the
object. When making paths,
the position of an object is
considered to be its centroid.
Paths are constructed as
follows:
a) Objects and their
centroids in the current
frame and the next frame
are found.
b) Pairs of objects, one in the
current frame, the other in
the subsequent frame, are
found, whose centroids
differ in position by <=5
pixels.
c) The closest such pair is considered to represent the position
of an object in the current and subsequent frame. This
portion of its path is noted and the object is removed from
consideration when matching other objects in theframe.
Return to step (b) unless no pair differ by <=5 pixels.
d) The distance value 5 above is called the 'current distance
threshold'. This threshold is incremented by 5 and step (b)
is repeated now using 10. That is, objects that have moved
<=10 pixels are sought.
This process continues using 5,10,15,... until the current
threshold exceeds the 'Max movement/frame' parameter. Objects
that move more than this distance in one frame will have their
path terminated. Any objects still remaining after this path
extension process for a frame are considered to be new objects
and new paths will be started with new object numbers.
Note: If the maximum movement parameter is
too large, one object will be associated with several
paths. Therefore, use the smallest workable
number. If an object moves so fast that its path is
segmented, the commands described in the
ViewPaths and EditPaths chapter (X), can be
used to splice the paths together.

Fig. 4.15. The 'Make Paths from Traces'
dialog box.
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Note: If the maximum movement parameter is
too small, two objects that have moved too close
together will have their paths confused. Again
this could be repaired by cutting and splicing
paths using ViewPaths and EditPaths.

4.12

'Min # pixels/object' is similar to the minimum and
maximum controls available under the automatic trace commands.
Use this entry to exclude small objects which have been
automatically outlined. The larger you set this number, the more
objects you will exclude. However, make sure to set it smaller
than the smallest object which you are interested in, in any frame.
The 'Min path length' command allows you to exclude
objects which may have passed through the movie image for a
short period of time. If you do not wish to include these objects
in future analysis, they may be excluded by making the path
length longer than they were in view. However, if objects move
more than the 'Max movement/frame', such as in a stage shift,
short, separate paths may be created for the same object. Make
sure that this does not happen by varying this number.
If you do not check the 'Allow new object' box in the
dialog box, then only objects whose paths appear in the first
frame will be included. Check this box if you wish to analyze the
paths of objects which appear later in the movie, or if a single
objects path may be truncated because of jumps in movement, as
described above.
The 'Allow static object' checkbox allows you to include
cells which periodically do not move. Not checking this box is
any easy method of eliminating debris which may have been
automatically outlined, but which will generally not move.
Generally, DIAS® will not include any object which runs
off of the edge of the screen. It does so because the morphology
of the object may be obscured by the loss of part of its screen
area. Clicking the 'Allow edge contact' command will keep such
objects as part of the path. However, realize that such data may
be incomplete because of the loss of part of the objects area.
The last command, 'Indicate initial objects', allows you to
select among the outlined objects in the first frame, in order to
determine which objects to include. If you select this option,
when you click 'OK' in the dialog box, the title bar of the movie
window will ask you to select the initial objects by clicking on
them. Doing so will add a dot to the object. When you have
selected all of the objects of interest, press the return key.
After making all of your selections, and clicking 'OK', a
dialog box will ask you if you wish to 'Include interior pixel data
in the path file?' (Fig. 4.16). This option gives you the ability to
include the actual interior image of each cell in later parts of the
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analysis, including viewing and editing dynamic paths (Chapter
VI), and shape analysis (Chapter XI). If you click 'No', only the
outlines will be included in those two analysis areas. However,
you should not include interior pixel data if analyzing more than
a few cells, and 100 or so frames, otherwise, you may overload
the resource fork of your file and damage or lose your file. Either
way you answer at this time will not effect the path making
process, visually.
After you have made your selection, DIAS® will outline
the objects in the first frame, and show the paths of movement in
a different color. Any new objects which appear after the first
frame will also have their shape in their first frame outlined,
assuming that you checked to allow new objects. As the program
is working, a box will display the frame numbers and number of
objects found as DIAS® works through the movie.
Before continuing, it is important for you to realize how
much editing should be done during this step. The most important
thing is that all of the cells/objects in which you are interested are
outlined and included. If the path of an object is broken, you can
tell because an outline of the object will appear somewhere
besides the first frame. You want to make sure that is because the
maximum movement allowance has been overrun, and not because
the outline of the object is open in some frame. If the reason has
to do with movement, it is easier reattach the paths later, using
commands under EditPaths. However, if an object is not included
in a certain frame because it was not traced, because the trace
was not closed, or for any other reason, there is no other point in
the program in which you can make that change. DIAS® offers
an array of other path display and editing capabilities, and they
will be explained later in chapters VI.
Understanding the above, notice that when DIAS® has
worked through the entire movie to find objects and paths, the
title bar will allow you to either accept or edit the paths. The title
bar will tell you to 'Click to Edit; Type r:redo and <cr>: done'.
You may click anywhere along the path lines. Doing so
will take you to that frame and place you temporarily in the
Trace on Movie mode. This is to allow you to make changes to
the traces in that particular frame. Again, this is designed
primarily to allow you to edit traces, add traces, or erase objects
which have been traced, which you wish to change for further
analysis. You can make these changes, using the capabilities
explained earlier, including moving to different frames. When
you are through editing, press the return key to take you back to
the make paths controls.
The other option you have is to type 'r'. Doing so will
bring you back to the original 'Make Paths From Traces' dialog
box, and you may change your options.
Once you have made all of your decisions and are

Fig. 4.16. The interior pixel data dialog
box.
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relatively happy with the paths created, press the return key. You
will be asked to name the new path file created.

Merge Parallel Path Files
This command allows you to merge already created path
files together over the same time points. This is primarily
directed towards the situation described earlier, when there are
several cells in the same movie. Because the cells were traced in
separate slots, different paths had to be made for each cell. After
each of the paths is made, they may be combined using the merge
parallel command.
After selecting this command, you will be prompted to
open each of the paths you wish to merge, using a standard
Macintosh open dialog box. Keep selecting relevant path files
until you are done, then click the cancel button. You will be
prompted for the name of the new path file.
Note: You may merge path files directly after
making them, or after editing them using the
commands under ViewPaths and EditPaths.

Merge Serial Path Files
This command is similar to the one described above,
except the it adds the paths one after another, sequentially. This
is used when short sections of a movie have been traced and
separate paths made. Follow the same directions as given above
for merging the path files into a single, longer, path.

Make Path File Segment
This command allows you to select a subsection of a path
file and to use it to create a new path file. You may wish to use
this if you want to analyze a single cycle, or other periodic
section of a path.
When you select this command, you will be prompted for
the name of the longer path file, and then for the frame range you
wish.

The rest of the DIAS menu
The remaining items under the DIAS menu pertain to
whole other sections of the program, and will be covered later in
the manual, under their own chapters.
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V
Editing the file header
What is the file header for?
The file header contains information which DIAS® uses
when calculating parameters, drawing graphs and charts, and
displaying and printing the outlines of your digitized objects.
The file header was originally created when paths were made.

Editing the file header
You can open and edit the file header for any path file.
To open and edit a file header, select Edit Path File Header
from the DIAS menu (Fig. 5.1). When the Macintosh® Open
dialog box appears, select the path file which you wish to edit.
The header for that file will appear on screen (Fig. 5.2).

Title
This can be anything. It will be printed out at the top of
graphs, etc.

Date
Automatically entered as the current date when outlining
first begins.

Time Unit
Used as the time unit in subsequent calculations and as
the time designation in charts and graphs.

Figure 5.1. Selecting Edit Path File
Header from the DIAS menu.

Distance Unit
This was automatically
determined when the scale factor
was measured. This unit of
measurement will be used in
subsequent graphs and charts. If
you change the unit, you must
also change the measurement.
For example, if the distance unit
is 'um' and the scale factor is
'1.2', to change the unit to 'mm',
the scale factor must be changed
to '1200'.

Figure 5.2. A path file header.

Frame Rate
This rate defines the time unit between frames. Specify
5.1
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the number of frames per time unit (may be fractional). If the
time unit is changed, the frame rate must also be changed. For
example, if the time unit 'min' and frame rate '12' is changed to
'sec', the frame rate must be changed to '0.2'.

Scale Factor
Entered automatically during the 'Measure/set Scale'
procedure. For more information, see 'Distance Unit'.

Screen Size
The window size in pixels. The default for this entry is
the size, in pixels, of the movie from which the path was created.
This may be changed here, or by using the Change window size
command under the ViewPaths menu.
Note: Even after you change the screen size, you
may not be able to fit an entire path on screen at
once if your actual monitor screen is too small.
However, you will be able to scroll around the
window after changing the screen size, and, in
that way, you will be able to view all parts of the
path.

Splines, resolution, bias and tension
The initial shape of the outline is determined during the
digitization process. It consists of a connected circuit of pixels.
The final shape is the mathematically precise shape of the object
after the following parameters have been applied to the initial
shape, resulting in a polygon with vertices specified by 6
significant digits of precision.
Beta splines replace the object's outline with curves that
approximate the original pixels. The idea is similar to using a
'French Curve' in drafting. It is beyond the scope of this manual
to define beta splines or to precisely define 'bias' and 'tension'. A
good reference is Computer Graphics and Geometric Modeling
Using Beta Splines by Brian A. Barsky, published by SpringerVerlag 1988.

Pre and Post-spline resolution
Resolution determines how carefully the curve segments
are drawn. 'Pre-spline resolution' refers to the number of pixels
to be used from the original outline. Because computer video is
made up of a series of pixels, your original outline will probably
have a jagged, or stair-stepped outline. That is only if you use
every pixel (100%). This has the effect of shutting off the splines
completely. Setting 'Pre-spline resolution' to 33% bases the
outline splines on every third pixel and allows splines to be used.
5.2
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You can experiment with what works best for you, but we have
found 33% to be the best 'Pre-spline resolution'. 'Post-spline
resolution' is similar in that you do not want to use all of the pixel
points when reconstructing your outline, since your splines will
be based on the stair steps. We have found 50% to be the best
setting. These settings will retain the correct shape for the
outline, while removing the jagged outline.

Bias and tension
'Bias' determines how the tangent line at a point on the
object's outline affects either side of the curve extending from
that point. A 'bias' of 1 is considered to be 'equal bias'. 'Tension'
determines how tightly the curve 'adheres' to the pixels. If the
tension is large, it is as if a tight rubber band is stretched around
the pixels. The default bias and tension is 1.0.
The easiest way to see the affect of entering different
values in the above four categories is to click on 'Expert spline
adjustment'.

Expert spline adjustment
The 'Expert spline adjustment' control panel allows you
to adjust all of the above settings simultaneously, and to see the
changes instantly. After selecting 'Expert spline adjustment' and
clicking 'OK', a dialog box will ask you which frame and object
in that frame you wish to see the effects of the various settings on
(Fig. 5.3). After making that selection, DIAS® opens up a
window and control panel (Fig. 5.4). In the window is
the current outline and original pixel points of the object.
The red points represent the outline created either during
automatic or manual outlining. The blue outline is the
mathematical representation of those points as
determined by the settings in the control panel below.
Experimenting with these settings is the easiest way to
see the effects of the various settings and combinations.

Figure 5.3. When selecting 'Expert spline
adjustment', DIAS® gives you the ability
to select a frame and object to work with.

Area and perimeter based centroids
If the perimeter-based method is selected for
determining the centroid (center) of a cell, the average
of the x and y coordinates, respectively, of the vertices
is used. If the area-based method is selected, t h e
mathematical center of mass is computed for
the polygonal shape, assuming uniform
density. This is also called the center of
area.
Note: If the object has holes, vertices
on the boundaries of holes count

Figure 5.4. The 'Expert spline adjustment'
control panel.
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towards the centroid computation with the
perimeter-based method. With the area-based
method, the interior of a hole does not contribute
to the center of area.

5.4
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VI
View/Edit paths
The View/Edit Path menu
While in the View/Edit Path mode, you may analyze and
edit paths created by DIAS®. You can delete, cut, and join
various paths, as well determine how the paths and outlines
appear on screen and on the printed page. You can use this
process to view the path of your cell's centroid or its outline
displayed over time. DIAS® also gives you the ability to difference
your images, allowing you to see expansion and contraction
zones. You can print the static pictures of these representations
or make dynamic digital reconstructions, or digital animations,
of these unique outlines, including QuickTime® movies.
To begin the process, select View/Edit Path from the
DIAS menu (Figure 6.1). A standard Macintosh® Open dialog
box will ask you to select a path file you wish to view, and after
doing so, a window will open, showing you the file (Fig. 6.2).
You may also enter these processes by opening a path file using
the Open command under DIAS®'s File menu. Opening a path
file automatically takes you the ViewPaths and EditPaths menus.
Note: Any changes made using the options under
the ViewPaths menu affect only how paths and
shapes are viewed on screen and printed, and do
not affect parameter calculations. Any changes
made using the options under the EditPaths menu
permanently affects the file and how parameters
will be calculated later.

The View/edit window
When the path file you have selected first opens,
you will notice several things. The title bar will list the
path file's name, the number of objects in the file, the
current frame number, and the total number of frames in
the file. In the window itself, you will see the outline of
the first object in it's first frame, and the centroids and
centroid paths of all of the objects in the file. Under the
ViewPaths menu (Fig. 6.3) you will find several
commands which will allow you to alter the current view
in the window and to make and save movies. Under the
EditPaths menu (Fig. 6.24) you will find several
commands which allow you to edit and change the paths
themselves. The commands under these two menus will be
explained below.

Figure 6.1. Selecting View/Edit Path
from the DIAS menu.

cell outlines
cell centroids
cell paths

Figure 6.2. An open path file, showing
cell outlines, centroids and paths.
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Select Object
Upon selection of this option, a dialog box will prompt
you for the objects (by number) which you wish to display (Fig.
6.4). The default is to display 'all' of the objects. To view any
subset of all of the objects, type in the numbers of the objects you
wish to keep on screen.
Note: In this step, and any other that asks for a list
of numbered choices, you can specify ranges ('48'), or type in a list separated by commas ('4, 5, 6,
7, 8'). Do not separate items by spaces, since
DIAS® will not accept the list in that format.
Note: Objects not selected for view are not deleted.
To view objects not currently being viewed, click
on Select objects and type in their number, or 'all'
(to restore the window to the default settings).

Centroid identification
After selecting this command, a message window will
prompt you to select a centroid with the mouse (Fig. 6.5). To do
so, position the cursor near a node (or centroid) and click the
mouse button. The number of the object, its frame number and
time will be displayed in the message window. If you do not
click directly on a node, the closest one is used. Repeat this
process as desired. To stop the process, click on 'Quit' in the
message window.

Centroid Velocity
Figure 6.3. DIAS® ViewPaths menu.

Figure 6.4. The 'View Objects' dialog.

This command will allow you to find out the velocity
(speed) for any specific object at any one time point. To find the
velocity of an object, select Centroid Velocity from the
ViewPaths menu. A dialog box will ask you to 'Select (a)
position with (the) mouse' (Figure 6.6). As you click on centroids,
shape outlines or paths, the dialog box will change and list the
object number, the frame number and the speed of the object at
that time point (Figure 6.7). When you are through checking
velocity, click on 'Quit' in the dialog box.

Figure 6.5. The 'Centroid identification'
message window.

Note: Speed is calculated based on the definitions
listed in Chapter VIII.

Figure 6.6. The 'Centroid Velocity'
message window, asking you to select a
object position.

Note: If you do not click directly on a centroid,
outline or path, DIAS® will calculate velocity for
the centroid closest to the spot you have chosen.
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Redraw
You should select this command if the screen becomes
cluttered. For example, if you have been drawing or typing in the
window, selecting Redraw undoes the work.

Figure 6.7. The 'Centroid Velocity'
message window, listing object number,
frame number and speed.

Note: You should select redraw after making
changes in the increment and magnification
settings.

Next frame
This command displays the outlines of the objects in the
next frame or at the next time point. If only the path is visible
(Show shapes is deselected) this will have no visible effect.

Previous frame
This command displays the outlines of the objects in the
previous frame or time point. If only the path is visible (Show
shapes is deselected) this will have no visible effect.

Go to frame
Selecting this command brings up a dialog box asking
you which frame to go to. The objects in that frame will be
displayed.

Display to
Display to is similar to Go to Frame except that all the
frames between the current frame and the one specified are
flashed onto the screen as a movie. This is a powerful display
tool when paired with stacking and differencing. When this
option is selected, a dialog box will ask you which frame to
display to and whether you wish to make a movie of the display.
To view the display, simply click 'OK'. To make a movie, type 'y'
or 'yes' in the dialog box and click 'OK'. You will then be
prompted to name the movie, for a movie type, and whether you
wish to compress your movie, as described in chapter III.
After you have chosen a movie format, you will be given
the option of adding additional information to the movie (Fig.
6.8). A dialog box will give you the ability to 'Title' your movie.
That title will appear in the upper left hand corner of your movie
as it displays. You will also be able to mark any single frame in
the movie (which may be used to signal a change in the
experiment) by having DIAS® outline the frame of the movie for
that time point. You can also show a continuous time change
throughout the frames ('Frame interval (sec)'), even starting by
counting backwards to a specific frame ('Time 0 frame'). These
are all options which can enhance your movie for a presentation,
but which do not permanently change your path file.

Figure 6.8. The 'Set Frame Parameter'
dialog box.
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Once you have made all of your choices, you will see
your movie play on screen. It is only at this point that the movie
is saved, so do not interrupt the process unless you do not want to
save the movie.

Show shapes
With this option selected (selection is denoted by a
checkmark next to the item on the menu) the outlines of all the
cells (or those selected by Select objects) appear in the window
(Fig. 6.9). The color, resolution, and size of
the shapes may be modified by selecting the
Show internal detail, Link to Original
the path of the cell's
Movie, Make B/W, Object edge color,
centroid over time
Object interior color, Vary object color,
Set beta splines, and Magnify commands,
described later. You can use the Next frame
and Previous frame commands to display
the shapes for different or multiple frames.

Show paths
With this option selected, the paths of all
the cells (or those selected by Select objects)
appear in the window. The color, time
intervals, and size of the paths may be
modified by selecting the Make B/W, Path
a stack of the outlines
color, Path node interior color, Vary path
(shapes) of the cell as it
color, Set increments, and Magnify
moves over time
commands, described later. When you first
select View/edit paths, the paths will be
shown as a default. Selecting Show paths
from the ViewPaths menu will turn off the
Figure 6.9. Examples of Show shapes,
paths. After deselecting Show paths, the
Stack images, and Show paths.
next time you select to Show paths, you will be given the option
to show a subsection of a path. A dialog box will ask you
whether you wish to 'View paths for a range of frames (yes) or a
single frame (no)?' (Fig. 6.10). If you wish to view the entire
path, select 'No', if you wish to view a subsection of the path,
select 'Yes'. You will be prompted for the frame numbers that
you wish to view. This is helpful if you are analyzing crowded
fields with overlapping paths.
Figure 6.10. The Show paths subsection
dialog box.

Stack images
When this option is selected and Display to is used, the
outlines of the objects in the current frame are not erased when
the outlines of the next frame are drawn. Figure 6.9 gives an
example of stacked images on the left and a centroid path (no
shapes) on the right.
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Difference images
With this option selected, the outline of the object in the
current frame is superimposed on the outline of the object in a
previous frame (Fig 6.11). Using the Set increments option
(described later), the number of frames, or time points, separating
the two outlines may be changed. The regions of the later
cell image not overlapping the earlier cell image are in contraction zones
green, and are considered 'expansion zones,' the regions of (usually in red)
the earlier cell image not overlapping the later cell image
are in red, and are considered 'contraction zones'. Areas
common to the cell image at both time points are in grey.

Change window size
This command allows you to change the size of the
window, in pixels, in order to fit more or less of the image
into the window. Making a change here will also change
the 'Screen size' in the file header. This may be very useful,
especially after joining paths into a longer path.

common area
(usually in grey)

expansion zones
(usually in green)

Show Centroid

Fig. 6.11 An example of a difference
picture.

When this option is selected, the centroid of the object is
shown as a circle in the interior of the object.

Fix centroids
When this option is selected, the objects will be locked
into one location (taking out the factor of motility) when drawing
the objects outline. This is accomplished by superimposing
centroids in sequential images. With this option and either Stack
images or Difference images selected, Display to provides a
view of pseudopodal extension and shape change in the absences
of centroid translocation.
Note: Show shapes, Show paths, Stack images,
Difference images, Show centroids, and Fix
centroids can all be used in varying combinations.
For instance, difference pictures may be stacked,
and the result saved as a QuickTime® movie.

Show internal detail
If you chose to 'Include interior pixel data in the path
file?' when making the current path, you may now choose to
display that internal detail, instead of using the standard colors.
To do so, select this option. You can also still stack and display
to images. However, because of the multi-color basis of
differencing, internal detail will probably be obscured.
Because the internal detail of the movie has actually been
saved to the path file, editing paths, magnification, and other path
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file changes should not effect the ability to display this internal
information.

Link to Orig(inal) Movie

Figure 6.12. An example of a stack of
outlines with actual object interiors linked
to the original movie.

Link to Orig Movie is similar to Show internal detail,
in that they both allow you to view the object's actual, original
interior while in View/Edit Path. However, there are several
differences between the two methods. As described in Chapter
IV, you should only include internal detail with a path file if the
movie/path is short, and there are very few objects. These
restrictions are memory based. However, including the pixel
data with the file is very robust in terms of later imaging. As
noted above, you can cut and paste paths, magnify, etc. With
Link to Orig Movie, no additional information is included with
the path file, so there are no memory limitations. This command
allows you to manually pick the movie to link it to. This
automatically and dynamically cuts and pastes greyscale data
from one file to the other. It reads the x & y coordinates from the
open path file, and captures the data within the same coordinates
from the selected movie file, showing it within the path file
shapes.
While this procedure allows you to link paths of a
significantly larger size, and including many more objects per
frame, there are limitations. Because of the exactness of the x,y
coordinate matching, this command will not work if you Magnify
within ViewPaths, if you Join Paths end-to-end, Change the
window size under ViewPaths or the 'Screen size' within the
header or make any other placement changes in either the path
file or movie file. You must also make sure to save and keep the
original movie file on your hard drive.
If you can work within these limitations, and did not save
the internal pixel data to the path file, you may use Link to Orig
Movie to display actual cellular information. To do so, select
Link to Orig Movie from the ViewPaths menu. A standard
Macintosh® Open dialog box will appear. Use this dialog to
select the original movie from which the path file was created.
After doing so, DIAS® will read the movie into memory and
replace the objects colored interiors with digital information
taken from the original movie (Fig 6.12).

Show path numbers
This command allows you to display, or turn off the
display of cell/object numbers.

Draw paths on top
Generally, when showing shapes, especially in conjunction
with Display to and Stack Image, the shapes are shown over top
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of the path files. Selecting this command will reverse that
layering. This is sometimes useful for publications and other
figures.

Colors
Under Colors there appears a submenu (Fig. 6.13) which
gives you control over the colors of various parts of the paths and
shapes. Most of them are self-explanatory. The Vary object
color and Vary path color are useful when viewing multiple
objects whose paths and outlines intersect and overlap. It makes
it easier to distinguish separate objects.

Figure 6.13. The Colors submenu.

Note: If you are going to select Make B/W for
printing, do so before using Display to, as
invoking Make B/W will erase all frames shape
outlines except for the current frames.

Set increments
After selecting this option, a dialog box will appear,
providing two types of increments which can be changed (Fig.
6.14). The first change you can make is in 'Frame inc.' The
default is '1', which means the nodes and shapes for every frame
will be displayed. A frame increment of 1 draws the centroids
and shapes for all frames. An increment of 2 draws centroids and
outlines in frames 1, 3, 5, ...etc. Changes in the frame increment
primarily affect the density of centroids and image outlines in a
path (Fig. 6.15). 'Difference increment' defines the meaning of
previous frame when showing difference pictures. The previous
frame number equals the current frame minus the 'Difference
inc(rement)'. If a 'Difference inc(rement)' is set higher than the
available number of previous frames available, no differencing
will immediately occur. Hence, if the 'Difference inc(rement)' is
set at '3', and you are currently one frame past the earliest frame
when you select Display to, no differencing will occur.
Differencing will begin with frame four. Figure 6.16 is an
example of how different 'Difference inc(rements)' can affect
your difference picture.

Figure 6.14. The 'Set Increment' dialog
box.

inc=1

inc=2

inc=5

Figure 6.15. Examples of 'Frame
inc(rements)' of 1,2 and 5 on both paths
and stacks of images.

Note: You should select Redraw and re-select
Display to after making changes in the increments
settings.
Note: Changes in increments do not affect
parameter calculations, or the time points which
will be used in graphs and charts. The changes
are for viewing and printing only.

inc=1

inc=2

inc=5

Figure 6.16. Examples of 'Difference
inc(rements)' of 1,2 and 5 on difference
pictures.
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Set Beta Splines
Selecting this option from the ViewPaths menu brings
up a dialog box with several bias, resolution and tension options
(Fig. 6.17). These were originally covered in chapter V and will
not be repeated here except to point out that the changes you
make here do not affect parameter calculations, but are designed
to affect viewing and printing only.
Note: If you made bias, resolution and tension
changes in the header, those changes are already
incorporated in the ViewPaths section, and do
not have to be repeated.
Figure 6.17. The 'Set Beta Splines' dialog
box.

Fig. 6.18. The magnification dialog box.

Magnify
This command allows you to magnify (or reduce) a
portion of the image. When selected, you are prompted for a
magnification factor (Fig. 6.18). This is always based upon the
original screen size (not the current magnification-if changes
have already been made). The magnification may be fractional
or as high as 600. After entering the magnification factor, the
user is prompted to select the center of magnification by clicking
the mouse. This will be the new center of the magnified screen.
To disable any magnification and return to the original screen
size, use a magnification factor of 0. If the new, magnified
images do not fit within the window, you may still Change
window size. When you leave ViewPaths, the current
magnification is optionally saved (via a prompt) so that when
you reenter ViewPaths later, the view will be the same.
Note: You should always select Redraw and
reselect Display to after magnifying.

Compute Data, Shape Analysis and Database
These options will be covered in subsequent chapters.

Quit ViewEdit
Select this to exit the View/Edit Path section. If changes
have been made, you will be asked whether you wish to save
them. If you simply close the window containing the paths and
outlines, the changes you have made will not be saved. You must
instead quit the View/Edit Path section of the program. This is
not the same as quitting DIAS®.
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Note: In the EditPaths menu (Fig. 6.19), there
are several commands which affect not only how
the paths are viewed on the screen, but how objects
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and paths are treated later during the calculation
of parameters. When you select Quit ViewEdit
from the ViewPaths menu, you will be asked if
you wish to save any changes you have made.
Remember, the changes also include changes made
in the EditPaths menu, and can affect which
paths (objects) are included when calculating
parameters.

Save Path
Selecting Save Path from the menu brings up a dialog
box asking you which objects (paths) to save (retain) (Fig. 6.20).
You may want to select this option if there are multiple paths,
and there are fewer you wish to save than delete. When typing in
a list of multiple paths, separate the numbers with commas; do
not use spaces. The default for this option is 'all'.
After you have typed in your selections and clicked on
'OK', the appropriate paths will be permanently removed, and
those remaining will be renumbered.

Fig. 6.19. The EditPaths menu.

Delete Path

Fig. 6.20. The 'Retain objects' dialog
box.

Selecting the Delete path option brings up a dialog box
asking you which objects (paths) you wish to remove (Fig. 6.21).
When typing in a list of multiple paths, separate the numbers
with commas; do not use spaces. The default is 'none'.
After you have typed in your selections and clicked on
'OK', the appropriate paths will be permanently removed, and
those remaining will be renumbered.

Fig. 6.21. The 'Remove Object' dialog
box.

Cut Path
Selecting the Cut Path option brings up a dialog box
asking you which object (path) you wish to cut, and after which
frame. After you make this selection, you will have two paths
(instead of one). The second path will start with the frame
entered in the dialog box in Figure 6.22 and be renumbered.

Join Fixed Path
If the path of an object you are tracking shows up in
DIAS as two or more paths, you will need to join paths in order
to calculate the correct parameters. DIAS® gives you two different
methods to do so.
The Join fixed paths command joins together two or
more paths without moving them, interpolating centroids if there
is a gap in time between the end of the first path, and the
beginning of the second. This is useful if a path was broken due
to digitization problems or collisions with other objects, or because
settings in the Max movement/frame number were too low
®

Fig. 6.22. The 'Cut Path' dialog box.

Fig. 6.23. The 'Join Paths' (both fixed
and end-to-end) dialog box.
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when making the path (Chapter IV). When the Join Fixed Path
dialog appears, list the paths you wish to join (up to 25 at a time).
They need not be in order, since the computer will automatically
sort them in the order of the paths starting times. If paths overlap,
the one that started earlier has precedence. When you type in the
numbers and click 'OK', a standard Macintosh® Save dialog box
will appear, asking you for the name of the new path file. When
you have typed that in and selected 'OK', the new path will be
drawn, and all the remaining paths will be renumbered. When
you first select either Join Fixed Paths, or Join Paths End-toEnd, a dialogue box will ask you which paths to join (Fig. 6.23).
Figures 6.24-26 are examples of original and joined paths.
Figure 6.24. The original path file with
two paths shown.

Figure 6.25. The same paths joined using
the Join Paths Fixed command.

Figure 6.26. The same paths joined using
the Join paths end-to-end command.
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The Join Paths End-to-End option differs from the Join
Fixed Paths in that the second path being joined is moved so that
its starting point is at the predicted (using linear interpolation)
location of where it would be if the object in the first path had
continued moving. This type of joining is generally used if an
object being viewed under a microscope keeps moving out of
view, and the observer has to adjust the microscope stage to recenter the object. The result of this type of action is the creation
of several paths beginning near the center and moving towards
the edge of the screen. The Join Paths End-to-End command
will allow you to reconnect the paths correctly, so that the
object's full path is viewable.
When the Join Paths End-to-End dialog appears, list
the paths you wish to join (up to 25 at a time). They need not be
in order, since the computer will automatically sort them in the
order of the paths starting times. If paths overlap, the one that
started earlier has precedence. When you type in the numbers
and click 'OK', a standard Macintosh® Save dialog box will
appear, asking you for the name of the new path file. When you
have typed that in and selected 'OK', the new path will be drawn,
and all the remaining paths will be renumbered.
Because the new path may be much larger than the
original, the entire path may not fit in the old window (and you
cannot scroll around the window to see the rest). If this is the
case, you will need to increase the 'Screen size' in the path file
header (Chapter VII). To do so, Quit ViewEdit, saving the
changes, open the file header for the path file you just created,
and increase the numbers in the 'Screen size' section of the dialog
box. When you reselect View/edit paths, you will be able to
either see the entire path on screen, or at least be able to scroll
around the window to see the entire path. When you first select
either Join fixed paths, or Join paths end-to-end, a dialogue
box will ask you which paths to join (Fig. 6.23).
Figures 6.24-26 are examples of original and joined paths.
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Note: Attempting to join paths of a single
timepoint may not work. If you are having
problems with broken paths, you may want to
change the settings during path construction,
specifically allowing for a larger movement per
frame.

Quit(ting) ViewEdit
Remember, you must quit the View/Edit Path section in
order to save any changes made to your path file.
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VII
Set Graph Size
Which graphs
This option is designed to allow you to vary the size of
the graphs generated during the Compute Parameters and Use
Database chapters (VIII & IX). When you select Set graph size
from the DIAS menu (Fig. 7.1), you will get a dialog box asking
you for the size of the graphs you wish to create, measured in
pixels (Fig. 7.2). As a reference, a standard Macintosh® 13"
monitor measures 640 (length) x 480 (height) pixels. The default
for a graph size is 500 by 400.
Note: You can set these limits larger than your
actual monitor, shrink the window later and use
the scroll bars to move around the graph if you
want to see more detail. You can also use the
Magnify command in the Graphics Manager.
However, magnifying the graph does not magnify
the window size.

Figure 7.1. Selecting Set graph size
from the DIAS menu.

Figure 7.2. The Set graph size dialog
box.
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VIII
Compute Parameters
Computing DIAS® parameters
In order to perform graphical and numberical analysis of
the motility and dynamic morphology for the cells you have
outlined, select Compute parameters from the DIAS menu (Fig
8.1). A standard Macintosh® Open dialog box will ask you
which path file you wish to compute parameters for. After typing
in the name of the path file and selecting 'OK', the DIAS®
'Compute Parameters' dialog box will appear. You may also go
directly to Compute Parameters by selecting that command
from under the ViewPaths menu, when you have a path file
open. There are several options and parameters (Fig. 8.2) available
under this command, and they will be described in detail below.

Objects
Enter the list of objects (paths) for which you wish data to
be computed. Entries must be separated by commas and ranges
are allowed. For example, '1,3-8,9' means the same as
'1,3,4,5,6,7,8,9'. Enter 'all' if you wish all objects to be analyzed.

First Frame
Enter the number of the first frame you want analyzed.

Last Frame
Enter the number of the last frame you wish analyzed.

Figure 8.1. Selecting Compute
Parameters from the DIAS menu.

Frame Increment
This is the increment added
to the first, and all subsequent frames
to get the subsequent frame number.
A frame increment of 2 will process
every other frame. The frame rate is
automatically corrected to take into
account the frame increment.
For example, assume that the
following values are entered (with 8
frames/min being the frame rate):
First Frame: 7
Last Frame: 32
Frame Increment: 3
The result would be as if the path
file had 9 frames with a frame rate
of 4=(8/3) frames/min, the 9 frames being (in the original frame

Figure 8.2. The DIAS ® 'Compute
Parameters' dialog box.
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numbers) 7,10,13,16,19,22,25,28,31.

Summary
A data summary will be
displayed if this option is
checked. The means and
standard deviations of the
selected parameters will be
shown. A summary will be
generated for each selected
object. A final summary, with
data averaged over all objects,
will also be generated.

All Data
For each selected object
and parameter, a list of the data
values of that parameter will
be displayed, indexed by frame
number (Fig. 8.3). This will
be covered in more depth later.
Figure 8.3. A sample data output.

Plot
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Figure 8.4. A sample graph.
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For each selected object and parameter, a graph is
generated, with time plotted on the x-axis and the data parameter
on the y-axis (Fig. 8.4). Two new menus with graphics functions
is provided with each graph, and the Graphics Manager (Chapter
IX) is entered. The number of graphs that may be displayed at
one time is limited only by the computer’s RAM memory. The
number of graphs generated can be greatly reduced by selecting
one or both of the 'Plot all objects on one graph' or the 'Plot all
parameters on one graph' options. For example, assume that you
have selected 3 objects and 5 parameters. Normally
this results in 15 graphs. The computer will plot as
many as possible, given the amount of memory
available. If 'Plot all objects on one graph' is selected,
only 5 graphs will be generated: each graph will contain
3 plots, one for each object. On the other hand, if 'Plot
all parameters on one graph' is selected, there will be 3
graphs, one for each object, with 5 parameters plotted
on each graph. If both are selected, only one graph will
result, with 15 plots. Too many plots on one graph
may seem awkward, but it is possible to use the Plot
and Axes menus to selectively view only the desired
35
40
plots.
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Make Database file
The numerical data generated by 'Summary' or 'All Data'
appears in a standard Macintosh® text window. You can save
and edit the text in this window with many standard Macintosh®
text applications. If you chose 'Make Database file' from the
diaog box, you can open this file in a format that makes cutting
and pasting between other applications (spreadsheets and graphing
programs) possible. To do so, use the View as text or Export
Data Files command under the Data menu (see Chapter X).
DIAS® also supports a more structured database file,
called a Data Text file, (of type 'DATA') with its own icon (Fig.
8.4). The database file is used in conjuction with the Use
Database command described in Chapter X. All of the 'DATA'
files collectively act as a database. The Use database command
is capable of manipulating several files from within the database
at one time. To create a DATA file, select 'Make Database File'.
A database file is created with the same name as your path file,
but with ‘.data’ appended. If you wish to use a different name,
highlight the current name and type in your new choice.

Figure 8.4. An example of the 'DATA'
icon.

Note: You can also open these files (using Open
under the File menu) and cut copy and paste
between other applications.

The Parameters
The user may check up to 33 parameters to be computed.
The definitions of the parameters are given at the end of this
chapter. 'Select All' and 'Clear All' buttons are provided for
convenience when selecting parameters.
The computation of the parameters is modified by three
items found at the bottom right of the dialog: Centroid Inc, Use
Central Differences, and Smooth Paths First. These are
discussed later in this chapter under the definition of the parameter
Speed. They affect only those parameters determined by centroid
movement. If either Positive Flow or Negative Flow are selected,
the user will be prompted for more information concerning the
calculation of these parameters.

Computing the data
Once the objects, frames, output mode, and parameters
have been selected, click 'Ok' to continue. As the computation
proceeds, a visual meter shows the progress. Type 'command-.'
to abort the computations, if desired. If 'Plot' is selected, graphs
will appear first, one by one, on screen. Finally, a text window
will appear with the 'Summary' and (if selected) the numerical
('All') data. If a graph is brought to the foreground (by clicking
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on it with the mouse), the Graphics Manager (Chapter IX)
menus will appear on the menubar. These menus will be covered
later in the manual. A graph can be saved to disk using the Save
command located under the File menu. It is saved in either a
native DIAS® graph format, or in the‘PICT’ image format. If
saved in the 'PICT' format, Plot and Axes functions must be
applied prior to saving - they will not be available when the
image is reopened. However, all drawing and painting options
will still be available. If you plan to work with data over a period
of time, it is best to have the data in a database file and select Use
database to invoke the Graphics Manager menus.

Object Shape and Centroid Definition
Figure. 8.5. Finding the base pixel.

Figure 8.6. The effect of useing a pixel
increment.

Figure 8.7. Splines disabled.

Figure 8.8. Beta splines enabled.
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Based on the original digitized outline of the object,
certain settings found in the Path File Header determine precisely
the meaning of ‘centroid’ and ‘shape’. Shape is determined by
1) Pixel Increment, i
2) Resolution, r
3) Bias, b
4) Tension, t
Bias and tension are beta spline parameters and are
described in Chapter V, Edit Path File Header. To make
changes in how shape is computed, make changes in the path file
header before selecting Compute parameters. The settings
made under the ViewPaths menu (See Chapter VI) only affect
how the objects look and are printed. Centroids are based on
shape and are computed by either the Boundary or the Area
method (see Chapter V for original selection of methods).
The initial shape is the outline produced by the original
digitization process. It consists of a connected circuit of pixels.
The final shape is the mathematically precise shape of the object
after parameters 1-4 have been applied to the initial shape,
resulting in a polygon with vertices specified by 9 significant
digits of precision. The final shape is determined from the initial
shape by the following steps:
1) Determine the base (or starting) pixel. A preliminary
centroid is calculated by averaging the x and y coordinates,
respectively, of the pixels of the inital shape. Now, starting at
the preliminary centroid, a scan is made towards the right until
a pixel of the initial shape is reached. This is the base pixel
(Fig. 8.5)
2) Prune out pixels using the pixel increment i. Let the
pixels be labelled (in a counterclockwise direction) p1,p2,...
with p1 being the base pixel. The pixels retained after pruning
are p1,p(1+i),p(1+2i),... . If the pixel increment is 1, all pixels
are retained. If the pixel increment is 2, every other pixel is
retained, etc (Fig. 8.6).
3) Determine the mathematical equations of the beta splines.
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If they are enabled. This results in a mathematically defined
curve segment associated with each pair of adjacent pixels
(after pruning from step 2). If splines are disabled,
the curve is taken to be the line segment joining
adjacent pixels (Figs. 8.7 & 8.8).
4) The resolution r is used to convert each curve
segment from step 3 into a sequence of line segments:
r+1 vertices are evenly spaced (by curve length)
along the curve segments. The vertices are connected
by r line segments. This is the final shape (Fig. 8.9).
The final centroid is computed: If the perimeterbased method was selected during the Edit path file
header process, the average of the x and y coordinates,
respectively, of the vertices from step 4 is used. If the
area-based method was selected, the mathematical
center of mass is computed for the polygonal shape
from step 4, assuming uniform density. This is also
called the center of area. All Time Series calculations
use this centroid for speed, acceleration, etc.

Figure 8.9. How various settings effect
of the final shape.

Note: If the object has holes, the above process is
repeated for each hole. Vertices on the boundaries
of holes count towards the centroid computation
with the perimeter-based method. With the areabased method, the interior of a hole does not
contribute towards the center of area.

Definition of the parameters
So that we may be precise in the descriptions, some
notation must be given. When we refer to the pixels P1,...,Pn of
a shape or its centroid we are referring to the final shape and
final centroid (Step 5 above).
Note: If the first frame, last frame, or frame
increment are other than the default, reread the
discussion above under Frame Increment. If,
for example, the selected frames were 7, 10, 13,
16, 19, 22, 25, 28, 31 (frame inc =3), the
computations proceed as if the file had 9 frames
numbered 1, 2, 3, 4, 5, 6, 7, 8, 9 with frame rate
1/3 of the original frame rate. In the following
discussion, ‘frame’ refers to the renumbered
frames.
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Notation:
F is the total number of frames. f is the ‘current’ frame.
(x[f],y[f]) are the coordinates of the centroid of an object
in frame f, 1<=f<=F.
I is the centroid increment.
n is the number of (final) pixels for a shape. P1,...,Pn
are the pixels.
frate is the frame rate in # of frames per unit time.
scale is the scale factor in distance units per pixel.
sqrt is the square root function.
abs is the absolute value function.
angle(x,y) is the angle (in degrees) that the vector from
the origin to the point (x,y) makes with the x axis. Positive
angles are measured counter-clockwise, as in
trigonometry.
NAN stands for 'not a number'. NANs do not appear as a
point on a graph and are not counted in an average.
x is sometimes used for multiplication

Speed
When the central difference method is selected, centroids
before and after the current frame are used to compute speed,
direction, etc. This gives a slightly smoother result, less influenced
by sudden ‘jumps’ of the centroid. Without the central difference
method, only the current and previous centroids are used.
Another way to reduce the effect of ‘jumps’ or ‘noise’ is
to increase the Centroid Inc(rement). By default it is 1. It
defines what is meant by ‘previous’ and ‘subsequent’ frames
during calculations. Increasing it will tend to emphasize more
general movement and will minimize small local movement.
The centroid increment is applied after the frame increment. If
the frame increment is 3 and the centroid increment is 2, centroids
in 6-frame time lags will be used for calculations. They will be
computed, however, every 3 frames.
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Definition of speed at frame f
Without Central Difference Method:
Speed[f] = 0 when f-I< 1
Speed[f] = (scalexfrate)xsqrt( ((x[f]-x[f-I])/I)2 + ((y[f]-y[f-I])/
I)2 )
when 1<=f-I
With Central Difference Method:
Speed[f] = (scalexfrate)xsqrt( ( (x[f+I]-x[f-I])/2I )2 + ( (y[f+I]y[f-I])/2I )2 )
when 1<=f-I and f+I<=F
Speed[f] = (scalexfrate)xsqrt( ((x[f+I]-x[f])/I)2 + ((y[f+I]-y[f])/
I)2 )
when f-I< 1 and f+I<=F
Speed[f] = (scalexfrate)xsqrt( ((x[f]-x[f-I])/I)2 + ((y[f]-y[f-I])/
I)2 )
when 1<=f-I and f+I>F
Speed[f] = 0 otherwise

Direction
Without Central Difference Method:
Dir[f] = angle((x[f]-x[f-I]), (y[f]-y[f-I]) )

when 1<=f-I

Dir[f] = angle((x[f+I]-x[f]), (y[f+I]-y[f]) ) when f-I< 1 and
f+I<=F
Dir[f] = 0 otherwise
With Central Difference Method:
Dir[f] = angle( (x[f+I]-x[f-I]) , (y[f+I]-y[f-I]) )
when 1<=f-I and f+I<=F
Dir[f] = angle((x[f+I]-x[f]), (y[f+I]-y[f]) )
when f-I< 1 and f+I<=F
Dir[f] = angle((x[f]-x[f-I]), (y[f]-y[f-I]) )
when 1<=f-I and f+I>F
Dir[f] = 0 otherwise
Note: Multiples of +/- 360 degrees are added to
the direction to make the graph continuous. For
example, an object moving in a spiral would have
directions: 0, 45, 90, 135, 180, 225, 270, 315,
360, 405, etc.
8.7
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Direction Change
DirCh[f] = 0 when f-I< 1
Dir[f-I] ) otherwise

DirCh[f] = abs( Dir[f] -

Note: if the direction change is greater than 180
degrees, it is subtracted from 360. This always
gives values between 0 and 180 degrees.

Acceleration
Without Central Difference Method:
Acc[f] = Speed[f] - Speed[f-I] when 1<=f-I
Acc[f] = 0 otherwise
With Central Difference Method:
Acc[f] = (Speed[f+I] - Speed[f-I])/2 when 1<=f-I and f+I<=F
Acc[f] = Speed[f+I] - Speed[f] when f-I< 1 and f+I<=F
Acc[f] = Speed[f] - Speed[f-I] when 1<=f-I and f+I>F
Acc[f] = 0 otherwise

Persistence
Persis[f] = Speed[f]/( 1 + (100/360)xDirCh[f] )
Note: Persistence is essentially speed divided by
the direction change (given in grads instead of
degrees). One is added to the denominator to
prevent division by 0. If an object is not turning,
its persistence is the same as the speed.

Centroid: X
CenX[f] is the x coordinate of the centroid at frame f. It
is given in pixel coordinates. It must be multiplied by scale to get
real world coordinates.

Centroid: Y
CenY[f] is the y coordinate of the centroid at frame f. It
is given in pixel coordinates. It must be multiplied by scale to get
real world coordinates.

Axis Tilt

8.8

To calculate this parameter we must first define the
major axis of an object. First, the pixel on the shape’s outline
farthest from the centroid is found. If there is more than one such
pixel, the one closest to the base pixel in counter-clockwise order
is used. This pixel becomes one end point of the major axis.
Now the pixel on the shape’s outline farthest from that end point
is found. Again, if there is more than one, the closest such pixel
to the base pixel is used. This is the other end point of the major
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axis.
The axis tilt Tilt[f] is the angle (in degrees)
that the major axis makes with the horizontal (always
less than 180 deg). See Figure 8.10.
Ideally, the major axis should be defined to be
the line connecting the two farthest points on the
boundary. If there were 200 pixels on the boundary,
about 20,000 distance calculations would be required.
This would vastly slow down the computation of axis
tilt. The method described above requires only 400
distance calculations.

Figure 8.10. Axis tilt.

Note: Multiples of +/- 180 are added to the axis
tilt to give continuity. Divide by 180 and take the
remainder to get the actual tilt. If an oblong
object is spinning at a constant rate, the axis tilt
graph will be a line of constant slope. The slope
will be positive if the object is spinning counterclockwise and negative if clockwise.

Mean Width
The Mean Width MeanWid[f] is defined as the area
(defined below) divided by the maximum length: MeanWid[f] =
Area[f]/MaxLen[f] . This turns out to be the same as the
average length of all chords (not counting the portions of the
chords that leave the object) perpendicular to the major axis. See
Figure 8.11.

Figure 8.11. Mean width.

Maximum Width
The Maximum Width MaxWid[f] is defined as the length
of the longest chord perpendicular to the major axis. See Figure
8.12.

Central Width
The Central Width CenWid[f] is defined as the length of
the chord through the centroid perpendicular to the major axis.
See Figure 8.13.

Figure 8.12. Maximum width.

X Bounded Width
The X Bounded Width XWid[f] is defined as the width
of the smallest enclosing rectangle (with horizontal and vertical
sides). See Figure 8.14.

Maximum Length
The Maximum Length MaxLen[f] is defined as the length
of the major axis defined above.

Figure 8.13. Central width.
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Y Bounded Width
The Y Bounded Width YWid[f] is defined as the height
of the smallest enclosing rectangle (with horizontal and vertical
sides). See Figure 8.15.

X Slice Width
Figure 8.14. X Boundedwidth.

The X Slice Width XSWid[f] is defined as the length of
the longest horizontal chord. See Figure 8.16.

Y Slice Width
The Y Slice Width YSWid[f] is defined as the length of
the longest vertical chord. See Figure 8.17.
Figure 8.15. Y Bounded Width.

Area
Area[f] is defined as the area of the final shape minus
the area of any holes. Let (x[i],y[i]) for i=0,...,n be the vertices of
the final shape, such that x[0]=x[n] and y[0]=y[n] (so that it ends
where it starts). Let dx[i]=x[i+1]-x[i] and dy[i]=y[i+1]-y[i].
Then area is computed (using Green’s Theorem) by:
Area[f] = 0.5xabs{ (x[0]xdy[0]-y[0]xdx[0]) + ... + (x[n-1]xdy[n1]-y[n-1]xdx[n-1]) }

Figure 8.16. X Slice Width.

Perimeter

Figure 8.17. Y Slice Width.

The perimeter Perim[f] is defined as the perimeter of the
final shape plus the perimeter of any holes. Let (x[i],y[i]) for
i=0,...,n be the vertices of the final shape, such that x[0]=x[n] and
y[0]=y[n] if the shape is closed. Let dx[i]=x[i+1]-x[i] and
dy[i]=y[i+1]-y[i]. Then perimeter is computed by:
Perim[f] = sqrt(dx[0]2 + dy[0]2) + ... + sqrt(dx[n-1]2 + dy[n-1]2)

Roundness

Round[f] = 100 x 4π x (Area[f]/Perim[f]2)
Roundness is a measure (in percent) of how efficiently a
given amount of perimeter encloses area. A circle has the largest
area for any given perimeter and has a roundness parameter of
100%. A straight line encloses no area and has a roundness
parameter of 0%. The factor 4π in the formula ensures that a
circle has 100% roundness. The perimeter is squared to make the
roundness scale invarient (i.e. dimensionless).

Predicted Volume
The predicted volume Vol[f] is the volume of the ellipsoid,
with circular cross-section, having length MaxLen[f] and width
MeanWid[f]:
Vol[f] = (4π/3)x(MaxLen[f]/2)x(MeanWid[f]/2)2
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Predicted Surface
The predicted surface area Sur[f] is the surface area of
the ellipsoid, with circular cross-section, having length MaxLen[f]
and width MeanWid[f]:
Sur[f] = CF x π x MaxLen[f] x MeanWid[f]
where CF is the ellipsoidal surface correction factor defined by
CF = Ú sin(x)xsqrt(sin2(x)+r2cos2(x)) dx
where r=MeanWid[f]/MaxLen[f].
Using Simpson’s Rule with N=10000, the computer approximates
this via the polynomial
CF = 0.15r2 + 0.065r + 0.785

Mean Radial Length
The mean radial length RadLen[f] is the average distance
of boundary pixels of the object to the centroid (holes are ignored).
Let n be the number of vertices of the final shape, indexed from
0 to n-1. Let L[i] be the distance from the i’th vertex to the
centroid. Then: RadLen[f] = (L[0] + ... + L[n-1])/n

Radial Deviation
The radial deviation RadDev[f] is the ratio of the standard
deviation of the above average to that average itself, written as a
percent. Let SD be the standard deviation of L[0],...,L[n-1].
Then:
RadDev[f] = 100 x SD/RadLen[f]

Convexity and Concavity
To compute Convex[f] and Concav[f], line segments
connecting the vertices of the final shape are drawn. The angles
of turning from one segment to the next are then measured.
Counter-clockwise turning represents a positive angle, while
clockwise turning a negative angle. For a closed outline, these
angles always add up to 360 degrees. This proceedure is repeated
for holes.
The total sum of the angles is 360x(1 + Number of holes).
Convex[f] is defined to be the sum of the positive turning angles,
while Concav[f] is the absolute value of the sum of the negative
angles (See Fig. 8.18). The following equation holds:
Convex[f] - Concav[f] = 360x(1 + Number of holes)
Convexity and concavity measure the complexity
of a shape. A circle has convexity 360 and concavity 0. A shape
(such as in Fig. 8.19) with K ‘arms’ will have convexity
approximately Kx180 and concavity Kx180-360 = (K-2)x180.
Each arm contributes about 180 degrees to the convexity.
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Positive and Negative Flow

Figure 8.18. Computation of Convexity
and Concavity.

Figure 8.19. A figure with arms.

Figure 8.20. 'Positive' and 'Negative Flow'
options dialog box.

Positive flow is essentially the amount of new area formed
in a certain amount of time (determined by the 'Flow
Increment' which is prompted for below). It is expressed
as a percent of the total area. Negative flow is the amount
of area lost in the same amount of time, written as a
percentage. In other words, positive and negative flow
measure the percent of area expansion and contraction of
an object per unit of time. If a cell has no z axis change
and no significant volume change during the Flow
increment, then the Positive and Negative Flow values
should be similar.
To make this more precise: Let f be the current frame and
FI be the Flow Increment. Let A be the interior of the shape
at frame f-FI, minus any holes. Let B be the interior of the
shape at frame f, minus holes. (If f-FI is less than 1, the
positive and negative flow are undefined). Let P be the area
in B that is not in A (P=B-A in Set notation). Let N be the
area in A that is not in B (N=A-B in Set notation). Then
define:
PosFlow[f] = 100 x Area(P)/Area(A) and NegFlow[f]
= 100 x Area(N)/Area(A)
If you select either Positive or Negative Flow from the
Time Series Parameters dialog box, you will see a dialog box
giving you options for how the flows will be measureed (Fig.
8.20). Flow increment refers to the time points between flow
measurements. For example, if each frame represents 5 seconds,
a Flow increment of 1 measures the % expansion/contraction per
every 5 sec. A Flow increment of 2 measures the % expansion/
contraction per every 10 sec. The centroids may be fixed before
comparing the shapes. This means that B is moved so that its
centroid matches that of A, before computing Positive and
Negative Flow. This has the effect of ‘subtracting out’ centroid
movement from shape change. As computations proceed, for
each object and each frame selected a window showing the
positive and negative regions appear.

Sectors
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Sector Area, Perimeter, Pos(itive) Flow, and Neg(ative)
Flow are derivative measurements of the standard parameters
Area, Perimeter, Positive Flow, and Negative Flow. These
parameters allow you to calculate the original parameters for 4
sections of the cells shape. When you select these options, you
will be presented with two dialog boxes which will help you to
determine how these parameters are calculated.
The first dialog box will ask you where to begin and end
your sectors (Fig. 8.21). The default is from 0 degrees to 360
degrees. This will give you 4 equal measurements of the entire
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shape of the cell. You need to enter a range of degrees that is
meaningful for your cells. 0 degrees is considered the topmost
point of the cells shape. Whatever range you enter will be
repeated all the way around with the second sector starting at the
end point of the first. For instance, if you entered 0 and 90 in the
dialog box, the sectors would consist of the sections measured 090 degrees (sector 1), 91-180 degrees (sector 2), 181-270 degrees
(sector 3), and 271-360 degrees (sector 4). Four sectors will
always be measured, so there may be some overlap in the later
sectors (if the initial sector is more than 90 degrees), or the entire
shape may not be measured (if the initial sector is less than 90
degrees). You can also start at any point. You do not have to
start at 0 degrees.
The second dialog box will ask you whether you wish to
'Use dir(ection) of travel for 0 deg(rees)?' (Fig. 8.22). The
default is 'No', setting 0 as the topmost point of the cells shape. If
you select 'Yes' here, 0 degrees becomes the point where the line
showing the direction of the cells movement crosses the cells
outline. The degree measurement calculated for the cell in a
particular frame now becomes degree 0 for these calculations.
After making your choices, a window will open displaying
the shape and/or flow for each object chosen. This will be
followed by the appropriate graphs and data.

Figure 8.21. 'Sector' definition dialog
box.

Figure 8.22. O degree dialog box.

NS and EW Dir Index
The 'NS' and 'EW Dir' parameters are each a chemotactic
index for general directionality. The 'NS' parameter measures
directionality in an up and down plane, with '1' denoting movement
straight northward, or upwards. The 'EW' parameter is the same
measurement with '1' being straight right, or eastward movement.
Neither of theses parameters are graphed, and only show up in
the summary.

Summary and Data Output
The summary (Fig. 8.23) gives the following information:
Time: The time of the beginning and the end of the path for
this object.
Total Elapsed Time: The ending time minus the beginning
time for the path.
Total Path Length: The lengths of the line segments
connecting centroids of the path are summed.
Net Path Length: The distance directly from the path
starting point to the ending point.
Directionality:
Total: The net path length divided by the total path
length. This gives 1.0 for a completely straight path and a
smaller value for a meandering path.
8.13
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Upward: This is defined to be: (Y coordinate of the end
of the path minus Y coordinate of the beginning) divided by
the total path length. This gives 1.0 for an object moving
directly upward and -1.0 for an object moving directly
downward.
An object whose net movement is only horizontal gives 0.0 .
Rightward: This is defined to be: (x coordinate of the
end of the path minus x coordinate of the beginning) divided
by the total path length. This gives 1.0 for an object moving
directly towards the right and -1.0 for an object moving
directly towards the left. An object whose net movement is
only vertical gives 0.0 .
Finally, the summary gives the means +/- the standard
deviations of the selected parameters.
Note: Sometimes parameters such as Area are so
large that the data printout is obscure. The best
way to handle this is to edit the File Header
(Chapter V) to change the units of distance and/or
time to be more convenient. For example, change
um to mm or in to ft, etc. Make sure you adjust
the frame rate and scalefactor accordingly.

Figure 8.23. A sample data output.
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IX
The Graphics Manager
Using the Graphics Manager
The Graphics Manager is accessed whenever a graph is
created while in the Compute Parameters, Use Database or
ViewPaths sections. The Graphics Manager adds two menus
to the DIAS® program, the Plot and Axes menus (Figs. 9.1 and
9.14). Definitions and descriptions of the options under the Plot
and Axes menus follow.
Figure 9.2 shows a typical graph with 3 items. Each
parameter in the graph has a color and a point style. At the
bottom of the graph, the x-axis item name is given followed by
‘vs’ and the y-axis items. Each item name is proceeded by its
point style and is in the color of its associated graph. The style,
size, and font of the text can be changed by making the appropriate
selections under the Option menu before creating the graph. The
graph can be annotated by using various text and draw features
located under the Edit menu. The graph can also be saved as
either a 'PICT' file or as a DIAS® graph file by selecting Save
under the File menu.

Select Item to Plot
This command allows you to change
which items to plot, and the color and point
style of the items you wish to plot. When
Select Item to Plot is selected, a dialog box
gives you various style and item choices (Fig
9.3). On the left are the colors for each item.
These colors refer to the color of the line
segments joining the points. Click on the
desired color to make a change. The ‘?’
color will display a standard Macintosh® color
wheel, from which the you can select any
custom color desired. To the right of the
colors selections are the point styles. The
'dash' represents the use of no point. The
items available to plot are listed on the
right. Click in the check boxes to select
or deselect the desired items. The 'Select
All' and 'Clear All' buttons let you select
all of the items or clear all of the items
with one mouse click. Click 'Ok' when
you have made your choices. The graph
will be redrawn according to your

Figure 9.1. The Plot menu.

Figure 9.2. A typical graph.

Figure 9.3. The Select Item to Plot
dialog box.
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selections.
Note that the X-axis item (here: Time) is not
selected. If it were, a diagonal line plotting time
vs itself would appear on the graph.

Co-plot Two Windows
This option will co-plot the y-axis items of the last two
graphs (windows) selected. To select a graph (window), click on
it or select it from the Windows menu. This will bring that graph
to the foreground. After selecting the two desired graphs
(windows), clicking the co-plot command creates a new graph
with all of the y-axis items from the two graphs plotted.

Redraw Plot
If for some reason the graph becomes cluttered or marred,
select this command to redraw the graph. It takes into account the
settings from Select Item to Plot and Graph Type. Annotations
made from the Edit menu (including all draw and paint
commands) will be lost.

Set interval limits
This option allows you to select a limited range for the xaxis, where means, smoothing, etc. are applied. After selecting
this option, instructions appear in the title bar asking you to click
on the left side of the range. You may click directly on the x-axis
or on a plotted point. Next, the title bar prompts you to click on
the right side. Select Redraw Plot if you wish to see the limits
drawn on the graph. These limits apply to the following
commands: Mean, Linear Fit, Find Maxima, Find Minima,
Smooth and Make Constant. To reset the limits, select Set
Interval Limit again and click on the extreme ends of the graph
to set the limits to the widest possible range. Then select
Redraw Plot to update the graph.

Mean
Figure 9.4. The 'Mean' window.

Figure 9.5. The 'Linear Fit' window.
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This option computes the mean and standard deviation
for all the data points of all 'selected' items between the limits
(from Set Interval Limits). The mean and standard deviation
are shown on the graph as horizontal lines. The numerical values
are displayed in a small window (Fig. 9.4). Click 'Ok' in the
window to continue.

Linear Fit
This option performs a least squares fit to all the data
points of all 'selected' graphs between the limits (from Set interval
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limits). All numerical values are displayed in a window: rr is the
coefficient of determination r2 , n is the number of data points, sx
is ∑x, sy is ∑y, sxx is ∑x2, sxy is ∑xy, and syy is ∑y2 (Fig. 9.5).

Quadratic Fit
Quadratic Fit is defined as a linear fit using 2ND degree
equations instead of lines (Fig. 9.6).
Figure 9.6. The 'Quadratic Fit' window.

See/Edit Point Value
When selected, you are prompted to click the mouse at
any point in the graph. The x and y values of that point are
displayed in the prompt window along with the name of the item.
If you wish to change the value, enter the new y value. Click on
'Done' when you are finished examining points.

Find Minima
After choosing this option, the local minima of all 'selected'
points between the limits (from Set interval limits) are shown as
vertical lines. A window displays the mean distance between
minima. Click 'Ok' in the window to continue.

Find Maxima
After choosing this option, the local maxima of all
'selected' points between the limits (from Set interval limits) are
shown as vertical lines. A window displays the mean distance
between maxima. Click 'Ok' in the window to continue.

Smooth
This option smooths the portions of the 'selected' items
between the limits (from Set interval limits). You are prompted
for the number of times you wish the smoothing to be done. A
Tukey window (described below) is used to determine the method
of smoothing.

Set Tukey Smooth Window
This selection determines the method of smoothing. The
Tukey window is a list of weights to be applied to each data point
and its immediate neighbors (Fig. 9.7). The default Tukey
window is ‘5, 15, 60, 15, 5’. Here each point of the graph is
averaged with the two points on either side for a total of five
points. A Tukey window may have any odd number of weights
that add up to 100. Denote 5 successive points by
(x[i-2],y[i-2]) , (x[i-1],y[i-1]) , (x[i],y[i]) , (x[i+1],y[i+1])
, (x[i+2],y[i+2]) .

Figure 9.7. The 'Set Tukey Window'
window.

Then the point (x[i],y[i]) is altered by smoothing (with window
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‘5 15 60 15 5’) to
x[i]= 0.05xx[i-2] + 0.15xx[i-1] + 0.60xx[i] + 0.15xx[i+1]
+ 0.05xx[i+2] and
y[i]= 0.05xy[i-2] + 0.15xy[i-1] + 0.60xy[i] + 0.15xy[i+1]
+ 0.05xy[i+2] .
Points at the beginning and end of the graph are handled in the
following manner:
x[1]= (0.05 + 0.15)xx[0] + 0.60xx[1] + 0.15xx[2] +
0.05xx[3] and
y[1]= (0.05 + 0.15)xy[0] + 0.60xy[1] + 0.15xy[2] +
0.05xy[3] .

Make Constant
After making this selection, you are prompted for a
value. All 'selected' items have their y values changed to the
number you entered. This affects only the points within the
limits determined by Set internal limits.

Keep Only Selected Pts
With this option, you are prompted to click on points
from the 'selected' items. Click on as many as desired. Click
'Done' when finished. All points on the graphs not clicked have
their y value set to zero.
Figure 9.8. The original data.

Translate Left/Right
After selecting this option, you are prompted for a value.
If the value is positive, all 'selected' points are translated (i.e.
moved) to the right by the amount specified. A negative value
indicates left translation.

Shift Up/Down and Scale
Figure 9.9. A Fourier transform of the
data.

Choosing this selection gives you a dialog box asking for
three values: Shift1, Scale, and Shift2. The y values of all
selected points are modified by the following formula: new y =
(y + Shift1)xScale + Shift2 .

Fourier Transform

Figure 9.10. A selection of frequencies.
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This option computes the Fast Fourier Transform (FFT)
of the currently selected parameters. The x-axis of the transform
becomes frequency - the number of cycles per time unit. Peaks
indicate a strong fundamental frequency component in the data.
A feature of the FFT is that the result is always symmetrical
about the vertical line dividing the x-axis into halves. The
frequency labels on the x-axis are significant only below the
midpoint. Lowest frequencies are on the left, while the highest
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frequencies are at the center. The user is prompted to optionally
select certain frequencies. If ‘Yes’ is selected, the user is prompted
to click the mouse at those frequencies to be retained (all others
are removed). Both left and right counterparts of the desired
frequencies should be selected (otherwise, the reconstructed
amplitude will be half the correct value when Inverse transform
is later performed). The result will show the selected frequencies
and the component waveforms plotted in various colors. Figures
9.8 and 9.9 show original data and the Fourier transform.
Figures 9.10 and 9.11 give an example of frequency selection.

Figure 9.11. The result of selection.

Inverse transform
From the frequency graph (and internally stored amplitude
and phase information), the original data is reconstructed. If an
entire range of frequencies is to be zeroed out (for high or low
frequency filtering), use Set interval limits followed by Make
constant to zero the FFT plot in a selected range; then apply
Inverse transform. Figure 9.12 shows the FFT with the high
frequencies removed. Figure 9.13 shows the Inverse FFT,
resulting in a high-frequency filter of the original data from
Figure 9.8.

Figure 9.12. The result of high
frequencies being zeroed out.

Convolution
Using the FFT, two parameters may be convolved or one
parameter may be self-convolved. Upon selecting Convolve,
you are prompted to choose one or two parameters. The
convolution of two functions f and g is defined to be:
Conv(s) =
f(x)g(x-s) dx .
Intuitively this means:
a) Pick a shift number s.
b) Take the mirror image of g about the y axis (called folding)
b) Shift the graph of the mirrored g to the right by s units.
c) Multiply the graph of f with the shifted mirrored graph of g.
d) Find the total area (regions below the axis count as negative)
of the result. This is the convolution value associated with shift s.
Convolution is included in DIAS® for the sake of
completeness only. Normally, correlation is used.

Figure 9.13. The Inverse transform of
Fig. 9.11.

Figure 9.14. The original data.

Correlation
Using the FFT, two parameters may be correlated, or one
parameter may be self-correlated. Upon selecting Correlate,
you are prompted to choose one or two parameters. The
correlation of two functions f and g is defined to be:
Corr(s) =
f(x)g(x+s) dx .
Intuitively, this means:
a) Pick a shift number s.
b) Shift the graph of g to the left by s units.

Figure 9.15.
correlation.

The result of self-
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*name
value
value
.
.
value
*name1
*name2
value value
value value
.
.
value value

Example
*speed
9.4
9.2
14.65
9.78
*length
*width
20.64 14.23
21.45 15.3
19.32 9.45
22.34 9.65

etc.
Figure 9.16. An example of the format
needed for imporatation of text files.

Title: Exported files from graph
Param: first item name
value
.
.
value
Param: second item name
value
value
.
.
value
etc.
Figure 9.17. An example of the output
type created using Export data as text.

c) Multiply the graph of f with the shifted graph of g.
d) Find the total area (regions below the axis count as negative)
of the result. This is the correlation value associated with shift s.
A peak on the left side of the correlation plot at x=K
indicates that the two parameters are similar when the second
parameter is shifted to the left by K units. Figures 9.14 and 9.15
show original data and the result of self-correlation.

Import Data From Text
This command reads new data items from a text file. A
standard Macintosh® dialog prompts the user for the text file
name. The format of the text file is shown in Figure 9.16. If the
data is listed as a single column of numbers, it is immediately
preceded by an item name beginning with a '*'. A blank line
should follow the last number. Data may appear in any number
of columns. There must be as many item names as there are
columns. Those names appear immediately before the data and
begin with '*'.
When the data has been read in, click on the Select Item
to Plot command to verify that the new items are there. To plot
them against the previous x-axis item, select the new items from
the selection dialog. If you wish one of the new items to be the xaxis, you must select the X-Y Crossplot command under the
Axes menu. You are prompted first for the new x-axis item, then
for the items to be plotted on the y-axis. At first, only the data
points will be visible. To make the lines connecting the points
visible, go to Select Item to Plot and choose a color for the (new)
x-axis item. This will be the color of the lines connecting the
points. You will probably also have to adjust the x and y axis
ranges using the Set X Axis and Set Y Axis commands located
under the Axes menu. They are described in detail below.

Export data as text
This command creates a text file that is compatible with
the Use database command (Chapter X). The data points for the
currently selected graphs are written to a file (a standard Save
File dialog prompts you for the name of the new file) in the
format shown in Figure 9.17. This is not the same format for
importing files (see above), but could easily be made so by
making the following changes (using any text editor) to the file:
1) remove the title line
2) replace 'Param' with '*'
Note: This data is also in a form that may be
easier to cut and paste from if you want to use this
data with other programs.
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Quit Plot
Click this to exit from both the Graphics Manager.
Changes in the data, made while using this program, have no
effect on data files.

Histogram
This command, under the Axes menu (Fig. 9.18), makes
frequency histograms of all currently selected items. After
making this selection, you are prompted for the histogram class
width (the width of a bar). The y-axis values are distributed into
classes (starting at 0) with this width. For example, a width of
0.5 gives classes (as half open intervals):
... [-1,-0.5) [-0.5,0) [0,0.5) [0.5,1) [1,1.5) ...
The frequency of y values in each class is counted and
plotted as bars, the width of the bar corresponding to class width
and the height being the frequency (Fig. 9.19). Keep in mind that
the class width refers to the y-axis and not the x-axis. Use Select
Item to Plot to alter the color of the bars. The color of the (now
unused) x-axis item determines the color of the bar outlines.

Figure 9.18. The Axes menu.

Standard Plot
Click on this command to return to the original graph,
after having selected Histogram.

X-Y Crossplot
This command lets you choose a new x-axis item and
also prompts for new y-axis items. Any parameter may be the xaxis. Only points are initially shown (as is usual for scatter
plots). If you wish to connect the points, use Select Item to Plot
to change the color of the x-axis item. The x-axis color determines
the color of the line segments joining the points. Usually the
ranges of the x and y axes must be changed when doing a
crossplot. See Set X-Axis and Set Y-Axis below. Figure 9.20
shows a scatter plot of speed vs roundness done with X-Y
Crossplot.

X-Y-Z Crossplot
This option allows you to plot parameters in three
dimensions. You are prompted to select one item for the x-axis
and one item for the y-axis. Then you are prompted to select any
number of items for the z-axis. As in X-Y Crossplot, only the
points are shown initially. All three axes may need their ranges
adjusted to see anything. See Set X-Axis, Set Y-Axis and Set ZAxis below. As before, the color of the line segments joining the
points is determined by the color of the x-axis item. Use Select
Item to Plot to change it.

Figure 9.19. A Histogram.

Figure 9.20. A scatter plot made with XY Crossplot
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View 3D as Stereo
When you have made an X-Y-Z Crossplot, it is possible
to view it using blue-red filtered glasses (left eye:blue, right
eye:red). Select this command to view the image with these
glasses. (A check mark appears beside the menu, indicating that
this view mode has been selected.) Select this command again to
turn off the stereo view mode.

View as Pseudo-stereo
Figure 9.21. A stereo plot viewed in pseudo
3D.

This command draws the X-Y-Z Crossplot, varying the
thickness of points and lines to simulate distance. It does not
require special glasses and may be printed. Select this command
a second time to turn off this mode. Figure 9.21 shows a pseudostereo plot.

Rotate 3D axes
Select this command to rotate your X-Y-Z Crossplot (in
any view mode). Rotation is about the z-axis. Rotation continues
until the mouse button is clicked.

Draw Grid
Select this command to have grid lines drawn on the
graph (either 2D or 3D). They are spaced at the same intervals as
the axis numerical labels. Select this command a second time to
turn off the grid.

Set X-Axis, Set Y-Axis, and Set Z-Axis
These commands allow you to determine the range and
labelling of the specific axes. Figure 9.18 shows a sample dialog
prompting for new x-axis values (The y and z axis dialog boxes
are similar). The minimum and maximum values determine the
range of the axis. The axis need not begin at 0. The increment
determines the spacing of the axis divisions which are labelled
numerically. The 'divisions' parameter determines the number of
minor marks between each pair of labelled ones. In the figure,
the labelled main divisions will be 0.0,0.1,0.2,...,1.0 . There will
be 10 subdivisions between each of these.

Show Error Bar
This command plots a second parameter relative to a
given parameter. For example, if the given parameter has value
5 and the second (relative) parameter has value 2, a line from
y=5-2 to y=5+2 will be drawn. Generally, the relative parameter
is an error or standard deviation associated with the given
parameter.
9.8

The Graphics Manager
Before using this command, select one parameter to
graph. Then select Show Error Bar. You are asked which
parameter is to be plotted relative to the initial parameter. The
color of that parameter determines the color of the error bars.
Figure 9.22 shows a sample error bar plot.

Magnify
After selecting this option, you are prompted for a
magnification factor (use 0 to return to the original view). You
are then prompted to click the mouse at what will be the center of
the new view. This can be used on any type of graph. The See/
Edit Point Value command works properly on a magnified
view.

Figure 9.22. A plot with error bars

Saving
Graphs can be saved as either DIAS® graphs or as 'PICT'
files. If you select Save from the File menu, a dialog box will
give you these two options (Fig. 9.23). If you elect to save the
graph as a 'PICT' file, you can still use the draw and paint options
under the Edit menu, but you cannot access the Graphics
Manager. If you save the graph as a graph file (Fig. 9.24), when
you open it, you can still manipulate the data using the commands
in the Graphics Manager.

Figure 9.23. The graph 'Save as' choices.

Figure 9.24. An example of a graph icon.
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Use database
Accessing the database
The Use Database command may be selected from under
the ViewPaths or DIAS menu (Fig. 10.1), and allows you to
view, plot and define functions based upon the data computed
and saved during the Compute Parameters step (Chapter VIII).
Since database files (Fig 10.2) are made up of specially formatted
text, the user may enter data directly into a file using many
ASCII text editors (including DIAS®). The format of the data
file is given at the end of this chapter.
After selecting Use Database from the DIAS menu, a
standard Macintosh® Open File dialog box appears prompting
you to choose a file. If a text file is selected that is not in the
proper format, an error message will appear. Use Database will
read a correctly formatted data file and display a summary of the
available items in a text window (Fig. 10.3).
The name of the file along with its title, date, etc. is
displayed. Then, each available item is listed. Obj(ect), First
(frame), Last (frame), and (frame) Inc are the same as in Compute
parameters (Chapter XI). Index and Time have the same
meaning for all objects and are not given an object number. The
Index counts from 1 to the total number of frames. A Data menu
also appears on the menubar (Fig. 10.4).

Append Data File
Any number of data files may be present at one time in
the display window. To add another, select Append Data File
and choose the desired file when the Macintosh® Open File
dialog box appears. New files continue numbering the items
where previous files left off, so that each item from any file has a
unique number. Most commands described below use these item
numbers to specify the
desired parameters.

Figure 10.1. Selecting 'Use Database'
from the DIAS menu.

Figure 10.2. An example of a database
file icon.

Clear Board
Clear
Board
removes all current files
from the display window
(the files themselves are
not altered). Select
Append Data File to enter
a new file.
Figure 10.3. A data summary file.
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Plot Items
Plot Items allows you to plot any number of items (on
the y-axis) against one x-axis item. When the item selection
dialog box appears (Fig. 10.5), specify one item for the x-axis
and any number of items for the y-axis. Separate these items by
commas or dashes. When this data is plotted, the Graphics
Manager is accessed. It can be used as described in the previous
chapter.
Note: Any changes made to the data while in the
Graphics Manager does not affect the 'DATA'
files.
Note: To get back to the Use database program
after plotting, either select Quit from the Plot
menu, close the graph’s window, or click in the
'DATA' file display window (Fig. 10.3). The
latter option does not erase the graph.

View as text
Figure 10.4. The Data menu.

This command allows you to view the data as a text file.
After you have selected this command, you will be prompted as
to whether you wish to 'Use tab delimited columns' (Fig 10.6). If
you select 'Yes', the text will be shown in a column form, which
can then be saved as a text file and imported by many spreadsheet
programs. If you select 'No', the text file will appear as a single
column, from which you can easily cut and paste into the same
programs.

Figure 10.5. The Plot Items dialog box.

Set Plot Size
By default, the size of a graph’s window is 500x400. Use
this command to change the graph window size (before selecting
Plot Items). A dialog asks you for the new length and height.
Figure 10.6. The View as Text dialog
box.

Figure 10.7. An example of the Display
Items tabular format.
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Display Items
This command lists the numerical data of selected
parameters. After selecting this
command, you are asked for
the list of items to be displayed.
You are then given the option
to display the data in either
columns or tables. The result
appears in a text window.
Figure 10.7 is an example of
the data in a tabular form. Each
row lists 10 consecutive frames.
In this example, the speed at
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frame 47 is 0.003 inches per second.

Show Mean
Upon selecting this option, you are prompted for a list of
items (Fig 10.8). All the values associated with each item are
lumped into an aggregate. The mean and standard deviation of
that aggregate are computed and displayed in a small text window
(Fig. 10.9). The number of aggregate values and the min-max
values are also displayed. For example, if three items are selected,
each having 200 values, the mean is computed for a total of
200x3=600 numbers.
Note: The commands so far described have no
effect on the data file contents. Except for Quit,
the remaining commands in some way alter the
'DATA' files.

Figure 10.8. The Show Mean 'Select
Items' dialog box.

Figure 10.9. A Show Mean 'Statistics'
dialog box.

Change Item Name
This command allows you to change the name of an item
(except item #1), it's object number, and the first and last frame
and increment of items. You are asked for a list of items to be
changed (Fig 10.10). For each selected item a dialog box appears
(Fig. 10.11). Make the desired changes and click 'OK'. The
changes are written into the data file containing the item.
Generally you will not want to change the frame limits or
increments.

Figure 10.10. The 'Rename Item' dialog
box.

Duplicate Items
After selecting this option, you are asked for a list of
items to be copied (Fig. 10.12). The duplicates have the same
name as the originals except that an '@' is inserted at the beginning
of the items name. If there is more than one 'DATA' file current,
you will also be prompted for the intended data file. The original
items are not affected by this command. This command is useful
when you want to smooth an item, while still retaining the
original.

Figure 10.11. The Change Item Name
dialog box with the original options listed.

Erase Items
Upon selection of this option, you are prompted for a list
of items to remove from the 'DATA' file(s). This command
cannot be undone. Important 'DATA' files that cannot easily be
remade should be backed up by duplicating them, using the
Finder.

Figure 10.12. A dialog box asking which
Items to Duplicate.

Interpolate Items
Items that have a frame increment other than 1 have
NAN's (Not A Number) as their values for intermediate frames.
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When plotted, the NAN's are ignored. When a table of values is
displayed, the NAN's appear as —'s. Use this command to fill in
the NAN-gaps using linear interpolation. Only the NAN's between
the first and last frames are interpolated. You are prompted for a
list of items to interpolate. This command is useful if you wish to
plot or define a function involving two parameters with different
increments.

Collapse Item
This command removes all NAN's, including those before
the first frame, for a parameter. If the original item started at
frame 25 and ended at frame 180 with a frame increment of 5, the
item will be listed starting at frame 1, end at frame 31 and have a
frame increment of 1. You are prompted for the list of items to
collapse.
Figure 10.13. The Shift Up Item dialog
box.

Shift Up Item
This option prompts you for the list of items to shift,
along with the number of frames (Fig. 10.13). If the original
parameter has values v1,v2,... , the result will have values NAN,...,
NAN, v1, v2,... , where the number of NAN’s inserted is the
number of frames to shift. Values pushed beyond the maximum
index are lost.

Shift Down Items
Figure 10.14. The Shift Down Item
dialog box.

With this option, you are prompted for the list of items to
shift, along with the number of frames to shift (Fig. 10.14). If the
original parameter has values v1,v2,... , the result will have
values vN+1, vN+2,... where N is the number of frames to shift.
The first N values are therefore lost.

Smooth Items
After selecting this option, a dialog appears (Fig. 10.15)
prompting you for a list of items to smooth, the number of
iterations (the number of times smoothed), and the Tukey window.
Tukey windows were described in Chapter IX.
Figure 10.15. The Smooth Item dialog
box.

Figure 10.16. The Framewise Mean
dialog box.
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Framewise Mean
This option averages several parameters, frame by frame,
in parallel. For example, take five parameters A,B,C,D,E. Let
A1,A2,... be the values of A at frames 1,2,... etc. , and similarly
for B,C,D and E. The resulting framewise mean parameter, M,
and framewise standard deviation parameter, S, are formed as
follows:
M1= Mean of {A1,B1,C1,D1,E1} S1= Standard Deviation of
{A1,B1,C1,D1,E1}
M2= Mean of {A1,B1,C1,D1,E1} S2= Standard Deviation of
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{A1,B1,C1,D1,E1} , etc.
You are prompted for the list of parameters to be averaged
(Fig.10.16). Two new items, 'Framewise Mean' and 'Framewise
Deviation', are created. As described in Chapter XI, the framewise
mean may be plotted, with the framewise deviation shown as
error bars (Fig. 10.17).

Itemwise Mean
After selecting this option, you are prompted for a list of
items. Assume that 5 items (parameters) are selected. Let A, B,
C, D, E be those five parameters. Let M(A), S(A) be the mean
and standard deviation of the values of parameter A, and similarly
for B, C, D and E. Two new items, 'Itemwise Mean' and
'Itemwise Deviation', are created. 'Itemwise Mean' will (in this
example) contain 5 values: M(A), M(B), M(C), M(D) and M(E);
'Itemwise Deviation' will contain the 5 values: S(A), S(B), S(C),
S(D) and S(E). In a sense, Itemwise Mean is perpendicular to
Framewise Mean. The number of frames in the 'Itemwise
Mean' and 'Deviation' parameters is the same as the number of
items selected.
The following is a situation where Itemwise Mean might
be used. Digitize 10 different cells and compute the speed for
each. Read the data file for each cell into Use Database.
Perform Itemwise Mean on the speed parameter for each cell
(10 parameters will be selected). Plot the resulting 'Itemwise
Mean' with 'Itemwise Deviation' as error bars. The x-axis indexes
the cell number. The y-axis give the mean alone with standard
deviation bar speed of each cell (Fig. 10.18).

Figure 10.17. The Framewise Mean of
the speed of 10 different objects showing
error bars.

Figure 10.18. The mean speed with
standard deviation bars for five objects

Apply Function
This command allows you to
define new functions based on the
items appearing in the Use Database
window. When selected, the
'Function Calculator' (Fig. 10.19)
appears.
Functions are defined using
RPN notation (Reverse Polish
Notation). The Function Calculator
allows up to 6 variables:
A,B,C,X,Y,Z. Three things must be
done to define a function:
1) Enter an item name in the New
Item Name slot.
2) Associate actual item numbers with the
variable letters A,B,C,X,Y,Z . Not all of the variable
letters need be used.

Figure 10.19. The mean speed with
standard deviation bars for five objects
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3) Enter a function in the Function slot, either by typing it in
directly or by clicking on the convenient symbol buttons.
The function is then applied to the selected parameters on
a frame by frame basis.

operation
A

stack top
A

sqr
B

A2
B

+
ln
A
C
+
/

A2+B
ln(A2+B)
A
C
A+C
ln(A2+B)/(A+C)

Fig. 10.20 Contents of the stack in a
computation

Let’s define a sample function. We wish to compute (for
each frame): newpar=ln(speed2 + area)/(speed+perimeter) .
In this example, assume that speed is item 3, area is item
5, and perimeter is item 7. Use the following steps:
1) Select Apply Function from the Data menu.
2) Enter 'NewPar' in the 'New Item Name' slot of the dialog.
3) Next to the 'A' button, enter 3 for 'Item Number'. This
associates the variable letter 'A' with item 3, speed.
4) Next to the 'B' button, enter 5 for 'Item Number'. So 'B' is
area.
5) Next to the 'C' button, enter 7 for 'Item Number'. So 'C' is
perimeter.
6) Now enter 'A sqr B + ln A C + /' in the 'Function' slot.
Either type it in directly, or click on the buttons with the
appropriate symbols.
When finished, the new item 'NewPar' appears in the
display window. Intermediate computations are held in a 'stack'.
Unary operations take the top number on the stack. Apply the
operation, and replace it back on to the
top of the stack. Binary operations
rest of stack —>
take the first two numbers on the stack.
—
—
Apply the operation, and put the result
—
—
on to the top of the stack (the original
A2
—
two numbers are removed from the
—
—
stack). When new items are added to
—
—
the stack, the stack contents are pushed
ln(A2+B)
—
down. Figure 10.20 shows the stack
A
ln(A2+B)
—
ln(A2+B)
contents for each step of calculation
—
—
for the above example.

Other features of the Function Calculator:
Save to file
After defining a function, click here to save the function
definition (but not the item numbers or the item name). You will
be prompted for the file name.

Load from file
This command is used to retrieve a function saved with
Save to file. You are prompted for the file name.
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Difference variables
The difference variables are 'dA', 'dB', 'dC', 'dX', 'dY',
and 'dZ'. Their values are affected by the difference increment
and the type (left, right or central). Here is the definition of 'dA'
(the others are analogous): Let A[1], A[2], ..., A[F] be the
values of parameter A for frames 1, 2, ..., F, where F is the
number of frames. Let I be the frame increment. The derivative
of A would be written as 'dA dt /'
1) Left differences
dA[f] = 0 when f-I< 1
dA[f] = (A[f]-A[f-I])/I when 1<=f-I
2) Right differences
dA[f] = 0 when f+I>F
dA[f] = (A[f+I]-A[f])/I when f+I<=F
3) Central differences
dA[f] = (A[f+I]-A[f-I])/2I when 1<=f-I and f+I<=F
dA[f] = (A[f+I]-A[f])/I when f-I< 1
dA[f] = (A[f]-A[f-I])/I when f+I>F

Specific frame variables
They are 'vA', 'vB', 'vC', 'vX', 'vY', 'vZ'. This allows you
to specify a value at a specific frame, other than the value at the
current frame. This is best described by an example. Let’s
normalize area (assume it is item 5) so that the first frame has
area 100. We wish to add (100 - first frame area) to the area in
each frame. If we associate the letter 'A' with item 5, so that 'A' is
area, the function definition is 'A 1 vA - 100 +'.
vA looks in the top of the stack for a frame number and
replaces it with the actual value of the parameter at that frame (0
results if the frame number is out of bounds). f is a special
symbol that stands for the current frame number. If we wanted to
define the function:
fun[f]= A[f]+A[f-1] when f>2
fun[f]= A[f] when f=1
we would use 'A f 1 - vA +' for the definition. Optional
parentheses (totally ignored by the computer) may be used to
clarify the definition: 'A (f 1 -)vA +'.
Another equivalent definition is '(f)vA (f 1 -)vA +'. In
fact the letter 'A' is equivalent to (f)vA.
Function calculations
Other 'Function Calculator' operation definitions are as
follow.
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Funtion Calculator Summary
Binary Operations
+
*
/
min
max
pow
hyp
ang

Stack Operations
clr
dup
exg

Takes x,y off the stack (x at the top).
Pushes y+x onto the stack.
Takes x,y off the stack (x at the top).
Pushes y-x onto the stack.
Takes x,y off the stack (x at the top).
Pushes y*x onto the stack.
Takes x,y off the stack (x at the top).
Pushes y/x onto the stack.
Takes x,y off the stack (x at the top).
Pushes the smaller of x,y onto the stack.
Takes x,y off the stack (x at the top).
Pushes the larger of x,y onto the stack.
Takes x,y off the stack (x at the top).
Pushes yx onto the stack.
Takes x,y off the stack (x at the top).
Pushes sqrt(x2 + y2) onto the stack.
Takes x,y off the stack (x at the top).
Pushes the (radian) angle the vector (y,x)
makes with the horizontal onto the stack.

Takes x off the stack. Pushes nothing.
Takes x off the stack. Pushes x back on twice.
Takes x,y off the stack. Pushes y,x back on.
Special Constants

π
dt
scale
nf

3.10159...
the time increment between frames
= item2[2]-item2[1] , since item2 is Time.
The scale factor in spatial units/pixel.
Total number of frames
Special Variables

f

The current frame during function calculation
Optional

()[]

Completely ignored. Used to improve readability.

Note: values come off the stack in the reverse order as they were
pushed. So: “A B -” is A-B “A B ang” is the angle made by
(A,B).
Special operations

Unary Operations
abs
sgn
neg
sqrt
sqr
int
exp
log
ln
r->d
d->r
sin
cos
tan
asin
acos
atan

Takes x off the stack. Pushes |x| onto the stack.
Takes x off the stack. Pushes sgn(x) onto the stack.
sgn(x)= -1 if x<0 ; 0 if x=0 ; 1 if x>0 .
Takes x off the stack. Pushes -x onto the stack.
Takes x off the stack.
Pushes sqrt(x) , the square root, onto the stack.
Takes x off the stack. Pushes x2 onto the stack.
Takes x off the stack.
Pushes the integer part of x onto the stack.
Takes x off the stack. Pushes ex onto the stack.
Takes x off the stack. Pushes log10(x) onto the stack.
Takes x off the stack. Pushes ln(x) onto the stack.
Takes x off the stack. Pushes (180/π)x onto the stack.
Takes x off the stack. Pushes (π/180)x onto the stack.
Takes x off the stack. Pushes sin(x) onto the stack.
Takes x off the stack. Pushes cos(x) onto the stack.
Takes x off the stack. Pushes tan(x) onto the stack.
Takes x off the stack. Pushes sin-1(x) onto the stack.
Takes x off the stack. Pushes cos-1(x) onto the stack.
Takes x off the stack. Pushes tan-1(x) onto the stack.

sA,sB,sC Integral sum. sum[f]= A[1]+...+A[f]
sX,sY,sZ “sA dt *” gives the integral.
scon

Simple condition.
Takes v,u,c,x off the stack (v at top).
if (x<=c) pushes u onto the stack ;
if (x>c) pushes v.
The form of the command is: (x c u v)scon
since they come off the stack in reverse order.

ccon

Complex condition.
Takes x,c,d,u,v,w off the stack (x at top).
if (x<=c) pushes u onto the stack ;
if (x>c & x<=d) pushes v.
if (x>d) pushes w.
The form of the command is: (x c d u v w)ccon
since they come off the stack in reverse order.

Function definition examples
1) Define the left difference of A directly, without using dA:
ldiff[f] = 0 when f<=1
ldiff[f] = A[f]-A[f-1] when f>1
The function definition is: f 1 0 [(f)vA (f 1 -)vA -] scon
So when f<=1 we get 0 and when f>1 we get [(f)vA (f 1 -)vA -]
Note: (f)vA could be more simply written as 'A'.
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2) Restrict parameter A to a maximum value of 100:
Function definition: [A 100 A 100]scon
3) Define a “20 60 20” Tukey window smoothing of parameter
'A':
Function definition:
f 1 nf A [(f 1-)vA 0.20* A 0.60* (f 1 +)vA 0.20* + +] A ccon

The DATA file format
We will indicate the format by giving an example.
Explanations are in bold type - they are not part of the file.
* DIAS TS Data File Any comment can follow a *
Title: Sample cellThe title of the file (required)
Date: 7/16/86
The date in month/day/year format (optional)
Trial: 1
Trial or experiment number (optional)
Frames: 10
Total number of frames (optional)
Objects: 1
Number of objects (optional)
TUnit: min
Unit of time (3 letters max) (optional)
SUnit: um
Unit of distance (3 letters max) (optional)
FRate: 12
Frame rate in frames/unit time (optional)
Scale: 0.74
Scale factor in units/pixel (optional)
SLen: 512
Raw data horizontal resolution (optional)
SWid: 512
Raw data vertical resolution (optional)
Pinc: 2
Pixel increment (optional)
Res: 3
Spline resolution (optional)
Bias: 0.5
Spline Bias (optional)
Tension: 2
Spline Tension (optional)
CenMethod: AreaMethod of centroid calculation (optional)
Note: Frame rate and scale factor must be specified if
you intend to use the constants dt or scale in function
definitions.

Param: Speed (um/min)
Obj: 1
Start: 1
End: 10
Inc: 1
25.3103
22.2739
15.4888
8.00085
9.49656
17.6906
31.4252
37.424
32.832
24.7711

Item name - must preceed each item

Object number (assume 1 if unspecified)
Starting frame number (assume 1 if unspecified)
Ending fr. number (use number of values if unspecified)
Frame increment (assume 1 if unspecified)
The values - one per line. NAN means Not A Number
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Param: Area (um-um)

Next Item name

Obj: 1
Start: 1
End: 10
Inc: 1
25.3103
22.2739
15.4888
8.00085
9.49656
17.6906
31.4252
37.424
NAN
NAN
Carriage return must follow last number in the file!

Export Data File
This command allows you to export the currently open
data file as a tab delimited text file. This type of file may be
opened in programs such as Excel for additional analysis.
This command is similar to selecting View as text, and
then saving the new file in a tab delimited format. However, this
command exports the information in the data file, instead of the
frame by frame data sets.
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XI
Shape analysis
The Shape Analysis section of DIAS® gives you the
ability to view an objects morphology, and its morphological
changes over time, using a variety of unique, static, images.
After selecting Shape Analysis from the DIAS menu
(Fig. 11.1), a standard Macintosh Open dialog box will ask you
which file to use. You must choose a path file. When you have
selected a path file, the Shape Analysis dialog box will appear
(Fig. 11.2).
The Shape Analysis dialog is divided into five sections.
1) Select objects and frames
2) Type of picture
3) Display mode
4) Size and direction
5) Color choice
Each section will be described below.

Select objects and frames
In this section, you may select which objects to analyze
(by number), the starting frame, ending frame and the frame
increment for the objects. The frame increment is only used to
determine the frames for which information is drawn. It does not
affect flow increment, centroid increment, or difference increment:
these are always based on the original frame numbers.

Type of Picture

Figure 11.1. Selecting Shape Analysis
from the DIAS menu.

There are three picture types
which may be generated during
Shape analysis. They are 'Shape
Pictures', 'Curvature Pictures', and
'Flow Pictures'.
'Shape Pictures' consist of
the actual digitized outline of the
object (as defined by the settings
under the path file header). In
addition to the outlines, you may
'Show centroids', 'Show direction',
and/or difference the pictures.
'Curvature Pictures' consists
of the amount of curvature along
the points of the boundary.
Curvature is the rate of turning of
the tangent line as it moves along the boundary of the object (in

Figure 11.2. The 'Shape Analysis' dialog
box.
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Figure 11.3. A demonstration of the
computation of flow

Figure 11.4. How curvature (and flow)
determine a shape.

degrees per unit of length). Counterclockwise turning is positive
curvature, while clockwise turning is negative curvature.
'Flow Pictures' consist of the amount of flow outward or
inward along the points of the boundary. Flow is computed as
follows: A flow increment FI is given. The shape
at the current frame is compared with the shape at
the current frame - FI (if not a valid frame, the
flow is zero). For each point on the boundary of
the current shape, a vector is drawn from the
centroid through that point. The place where this
vector intersects the earlier shape, closest to the
original point, is found. The directed distance
between these two points is the flow (See Fig.
11.3). Positive flow indicates outward movement,
while negative flow indicates inward movement.
Curvature and flow yield a shape in the following
manner: Curvature and flow are
computed at each point along the
boundary of the original object.
The boundary pixels are
determined (taking into account the
spline settings and pixel increment)
as described in the Compute
parameters and Edit path file
header chapters. The vector from
the centroid to each boundary point
is noted. The length of that vector
is changed to be the amount of curvature or flow (if negative the
vector points in the reverse direction). The point of the resulting
shape is drawn at the end of this vector (See Fig. 11.4). To avoid
negative numbers, a bias can optionally be added to all curvature
and flow values, and the 'Size factor' may be varied. Bias is
described in section 4, under 'Size and direction'.

Differencing

11.2

Any of the three types of pictures may optionally be
differenced. A difference increment (frames), DI, is specified in
the 'Shape Analysis' dialog box. The pictures (of whatever type)
are computed for the current frame and the current frame -DI.
They are then superimposed, either with centroids at their actual
position, or optionally, with their centroids fixed in the same
place (check 'fixed centroid' to the right of 'Difference by').
Regions of the interior of the later picture, not contained in the
earlier picture, are shown in green. Regions of the interior of the
earlier picture, not contained in the later picture, are shown in
red. The intersection of both regions is shown in gray. This type
of differencing is the same as that described in the chapter
ViewPaths (Chapter VI).

Shape Analysis
Modes of display
There are four modes that determine the way pictures are
drawn and displayed:
1) Graph
2) Tabular
3) Stacked
4) Circular stacked
In the 'Graph' display mode, the shapes are 'unwrapped'
either by angle or by boundary length (see below) and plotted
(Fig. 11.5). Because the shape of each frame is graphed, limit the
number of frames to 10 for this display mode. When unwrapping
does not result in a true function, the largest of several values
with the same x-coordinate is used. After the graph is drawn on
the screen, the Graphics Manager will become active (Chapter
IX).
In the 'Tabular' display mode, pictures are displayed in a
matrix of subwindows (Fig. 11.6). You can specify the size of
each subwindow (in 'Box length' and 'Box height') and the
number of subwindows across and down (by changing the '6 x 4'
to the right of 'Tabular').
In the 'Stacked' display mode, the shapes are 'unwrapped'
either by angle or by boundary length (see below) and plotted,
each plot offset lower than the last (Fig. 11.7). The stack offset
determines the amount of offset (in pixels).
In the 'Circular stacked' display mode, the shapes are
drawn in one window, centroids fixed at the center of the window,
with the scale expanding at a constant rate, frame by frame. The
shape for the first frame is drawn smallest. The shape for the
next frame is drawn slightly larger, etc. (Fig. 11.8). The stack
offset determines how much larger (in pixels) one picture is than
the last. This is done by adding successive multiples of the offset
to the radius vectors determining the shape.
Both of the stacking modes produce images which are
helpful in displaying global shape change over time, as well as
rhythms in those changes.

Figure 11.5.
graphed.

The shape of an object

Figure 11.6. 'Shape' pictures shown in a
tabular form with centroids and direction
shown.

Figure 11.7. 'Stacked' pictures.

Unwrapping
Unwrapping by angle is a conversion from polar to
rectangular coordinates (with the centroid as the polar coordinate
origin). Let P1, P2, ... be the points of the boundary of the shape
to be unwrapped. Let (R1,T1), (R2,T2), ... be the polar coordinates
of the points (R1=distance to the centroid and T1=the angle of
the vector connecting the centroid to the boundary point). The
unwrapped points are plotted as (T1,R1), (T2,R2), ... in (x,y)
rectangular coordinates. The x-axis is the angle and the y-axis is
the distance to the centroid. The result is not always a simple
function, since a complex shape may have more than one boundary

Figure 11.8. 'Circular stacked' pictures.
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Figure 11.9. A 'Shape' picture unwrapped
using the 'Angle' method, and graphed.

point at the same angle.
Unwrapping may also be done by boundary length. Let
P1, P2, ... be the points of the boundary of the shape to be
unwrapped. Let (R1,L1), (R2,L2),... be the coordinates of the
points parametrized by boundary length: R1, R2,... are the
distances from the points to the centroid and L1, L2,... are the
boundary length distances (length measured along the arc of the
boundary) of the points from the first point P1. Hence L1=0,
L2=distance along the shape’s boundary from P2 to P1, etc. The
L1, L2,... are always increasing, as no two points have the same
boundary length from P1. The unwrapped points are plotted as
(L1,R1), (L2,R2),... in (x,y) rectangular coordinates. The x-axis
is the boundary length and the y-axis is the distance to the
centroid. The result is a function, since no two points have the
same L value. Figures 11.9-11.12 illustrate the difference between
unwrapping by angle and unwrapping by boundary length.

Size and direction

Figure 11.10. A 'Shape' picture
unwrapped using the 'Boundary Length'
method, and graphed.

Figure 11.9. A 'Shape' picture unwrapped
using the 'Angle' method, and 'Stacked'.

Figure 11.10. A 'Shape' picture
unwrapped using the 'Boundary Length'
method, and 'Stacked'.
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'Size Factor' gives you the ability to increase the size of
any of the picture type outputs. Increasing the 'Size factor' only
works in the 'Tabular', 'Stacked', and 'Circular stacked' modes,
and if in the 'Tabular' mode, you may want to increase the length
and height of the boxes in order to fit the entire shape picture. A
size of 1 is the original digitized size. To double the size use 2,
etc. Fractional sizes are allowed.
'Bias' refers to a constant that is added to the 'radial'
lengths of whatever object is being plotted. This should only be
used when creating curvature or flow pictures. This is done to
avoid negatives.
'Smoothing' is primarily for the 'Curvature' and 'Flow
Pictures' and 'Stacks'. The number entered refers to the number
of rounds of 'Smoothing'.
'Show Centroids' displays the centroids of the objects,
provided it makes sense to do so, given the display mode.
'Show Direction' shows the direction of centroid
movement. In tabular form, the direction is shown as an arrow
emanating from the centroid. In the stacked modes, the direction
is shown as a red mark on the objects boundary where the
direction vector would intersect. Figure 11.6 shows both centroids
and direction as part of a 'Tabular' 'Shape Picture'. The next two
items allow you to specify exactly how direction is to be computed:
Centroid Inc:
This is the frame increment used for the computation of
direction. See the chapter on Computing Parameters (VIII) for
the definition of direction using a frame increment. Increasing
this increment tends to smooth out local variations of centroid
movement. This increment is totally independent of the frame

Shape Analysis
increment or the difference increment, described earlier in this
chapter.
Central Diff Method:
Check this to use the central difference method for
computing direction (described in the Computing Parameters
chapter-VIII).
Note: If you are drawing difference pictures and
want the direction arrow to actually connect the
centroids, set the 'Centroid Inc' to be the same as
the 'Difference Inc' and un-check 'Central Diff
Method'.

Color choice
Select the desired edge and fill color for objects. When
differencing, edge color is the expanding portion and fill color is
the contracting portion while the current drawing color (set from
the Option menu) is the intersection color. If 'None' is selected
for the fill color, green, red, and gray will be used for differencing.
You may also choose to set all colors to black and white
by checking the 'Set black and white color' box, in order to match
output to your printer. If you selected to include internal pixel
detail when constructing paths (Chapter IV), you may include
that detail here.

To start drawing once selections have been made
Click 'OK' when you have made all the desired selections.
Unless you chose 'Graph', a new window appears and the program
begins to draw in it. If you wish to stop the drawing, click the
mouse button to interrupt. You are then asked whether you wish
to save what has been drawn so far. If you choose 'Yes', the
Shape Analysis program quits, leaving the window on the screen.
If you select 'No', you are returned to the Shape Analysis dialog
box so that you may alter the settings and try again. This is
especially useful for correlating the 'Size Factor' with other
settings.
Note: Because the Shape Analysis dialog box is
complex, once you have determined working
settings for your objects, you may want to save
those settings, using the 'Save setting' button, so
that they may be recalled later, using the 'Load
setting' button.
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XII
Measure Relative Flow
What can this tell me
The Measure Relative Flow command gives you the
ability to measure, as percentages, the changing morphology of
cells. This is done by comparing the percentages of area
represented by the three different colors displayed in a difference
picture.

Measuring relative flow using difference pictures
The Measure Relative Flow command is always available
under the DIAS menu, but before selecting it (Fig. 12.1), you
must have a 'PICT' image file open on the desktop. This command
is designed to work with the 'Tabular' difference pictures you
created using the commands in the Shape Analysis dialog box
(Chapter XI). You may either have just finished creating the
pictures, or you can have created and saved them previously.
After opening the appropriate file and selecting Measure
Relative Flow, the title bar will instruct you to 'Click on the 1st
color representing the total', then to click on the second and third
colors making up the total of the difference picture (red, green,
and grey). For each color, simply place the mouse pointer
anywhere the color appears in the shape and click.
After picking the colors, you are then prompted as to
whether you wish the flow measurement values to be placed
automatically. If you answer 'Yes', after measuring flow, DIAS®
will automatically place the percentage measurement numbers
within the image. This is generally the easiest method. However,
if you are planning to publish the image, or wish for more control
over the presentation of the image, select 'No'. After selecting an
area to measure, you will be able to pick where the measurement
number is to be placed, using the cursor.
Once you have answered the placement question, the title
bar will prompt you to 'Box in the desired region (difference
picture)'. To do so, draw a bounding box around the entire
difference picture, but within the bounds of the 'Tabular' box
(Fig. 12.2).

Figure 12.1. Selecting Measure Relative
Flow from the DIAS menu.

bounding box

'Tabular' box

Note: Total area is defined to be the number of
pixels having one of the 3 colors you have chosen.
If you wish to use less than 3 colors, click on one
color more than once, so that a total number of 3
clicks have been made. For example, a difference
picture is comprised of red, gray and green. The

Figure 12.2. An example of how to draw
a bounding box.
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area of the earlier image is the red and gray parts,
and the area of the later image is the green and
gray parts. If you wish total area to be that of the
earlier object, click on red twice.
Once this is done, the title bar will ask you to 'Click to
measure (the area of interest)'. You may click on any red, gray or
green portion within the enclosed region. The percent area of
that portion (equal to the number of all pixels of the same color,
connected to the portion you selected) relative to the total area
(as defined by the 3 clicks above) is computed. If you selected
automatic placing, the % ratio will automatically be placed next
to the selected portion. If not, the cursor becomes a text insertion
bar and the title bar asks you to 'Click to position (the %
measurement)'. Repeat clicking on portions to measure as needed.
When done with one picture, click on the return key.
You are again prompted to select a rectangular region
enclosing another difference picture. If you are completely
finished, click the return key again to exit this section of the
program.

Subwindows
Before clicking on a portion to measure, you may
optionally type the 's' key to select a subwindow in which to
restrict a flow measurement. Use the mouse to draw the
rectangular subwindow. Now, when you click on a portion
inside the
subwindow, all
pixels of the
same color only
within the
subwindow are
counted. Figure
12.3 shows an
examples of flow
measurements
and windowing.

Measuring
within a
subwindow

Figure 12.3. Examples of relative flow
measurements.
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The File menu
File
The File menu (Fig 13.1) contains standard commands
for opening and closing files, for printing, and for saving various
files, images and movies.

New Image
This command creates a new, empty graphics window
you can use to copy figures into, or draw in. When selecting this
option from the File menu, you will get a dialog box asking you
to define the New Image window (Fig 13.2).
'Title' is self-explanatory. 'Horizontal Length' and 'Vertical
Width' are asking for the size of the image in pixels. As a
reference, a standard Macintosh® 14'' monitor measures 640 x
480 pixels. If you create a new window larger than this, you will
have to use the scroll arrows to move around in it.

New Text

Fig. 13.1 The File menu

This command creates a new text window which can be
used with the various options under the Option menu.

Open and Close
These commands are standard to the Macintosh® operating
system and so will not be covered here accept to say that you can
use the Open command to open any standard 'PICT' or
QuickTime® file (from any program) or any DIAS® files.

Save
This command may offer several options before getting
to the actual 'Save' dialog box, which prompts you for the name
you wish to save the file under. Those other options have been
covered throughout the manual.
We recommend using this command often.
Note: Saved DIAS® text files should be openable
by many standard text processors. DIAS® image
files are saved as high-resolution PICT files, and
should be openable by many image processors
(make sure to set them for 300dpi). DIAS® data
files may exported for use in programs such as
Excel. DIAS® movies may not be opened in any
other programs, but may be exported as
QuickTime® movies for use in other programs.

Fig. 13.2 The New Image dialog box
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Memory Map
The 'Memory Map' is a window which contains a visual
display of memory allocation and usage for DIAS® (Fig. 13.3).
When this command is selected, a new window will open,
displaying the total memory allocated for the program, and the
current usage of memory. Memory usage will be displayed by
blocks of color. As the window fill up with color, you are using
more memory. You may leave this
window open, and in the background
while using the program to check for
low memory.
Fig. 13.3 The 'Memory Map' window

Fig. 13.4 The Page Setup dialog box for
the Apple LaserWriter Pro 600 and the
LaserWriter 8.0 driver

Page Setup
This command allows you to set the printer options that
are available for your printer. Figure 13.4 shows the Page Setup
dialog box for the Apple LaserWriter Pro 600 using the
LaserWriter 8.0 driver. Because the dialog box you get, and the
various options involved, will differ by printer and driver, the
specific options will not be covered here. If you wish to learn
more about them, you can get the documentation from Apple, or
turn on and use the 'Help Balloons', using the Show Balloons
command under the '?' menu at the right of your screen (Fig
13.5).

Print Preview
Fig. 13. 5 How to activate Balloon Help

This command will open up a new window, displaying a
low resolution copy of the current window. This is done to
preview placement of images for printing. Do this to make sure
that the current image fits on one page. If it does not fit, part of
the image will be cut off in the preview. If that is the case, go
back to Page Setup and either reduce the image or change its
orientation.
Close this window before actually printing.

Print
After selecting this command, a printer dialog box will
appear. Because different printers and drivers use different
dialog boxes, this dialog box will not be covered, except to
suggest using Show Balloons if you have a question.
After making your selections, click on 'OK' to print the
document.
Note: A printing trick. If you wish DIAS® to use
thinner lines to print out shapes, such as in
ViewPaths and Shape Analysis, double the size
of the image using the Enlarge command under
the Image menu, then reduce the printed image
13.2
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using a setting of 50% in the 'Reduction' section
of the Page Setup dialog box. This will give you
an image of the same size, with thinner lines.

Quit
This command returns the user to the Finder. If there are
any DIAS® windows open and changed, the user will be asked
for confirmation before quitting.
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XIV
The Edit menu
The Edit menu
The Edit menu contains standard Cut, Copy and Paste
commands, as well as other, related, capabilities.

Undo
The Undo command undoes the effects of the last Edit or
Image menu command. Undo does not affect changes in contrast.

Cut
The Cut command deletes any highlighted text if you are
in a text mode. If you are working on an image, first select Cut
from the Edit menu, then click and drag an enclosing rectangle
around the area you wish to Cut from the image. The part of the
image contained within the rectangle will be removed from the
current image and placed in the clipboard for copying.

Fig. 14.1 The Edit menu

Copy
The Copy command is similar to Cut in that it places the
selected text or image in the clipboard. Unlike Cut, the selected
information is not removed from the current window. Instead, a
duplicate is created and placed in the clipboard.

Paste
When working with text, Paste places the text captured
during the Cut or Copy commands in-line with the other text.
The insertion point is the current location of the cursor. When
working with images, selecting Paste places a rectangle the size
of the image captured during Cut or Copy on top of the current
image. You can move the rectangle by moving your mouse.
Clicking the mouse button places the actual image in place of the
rectangle. If you do not like the placement of either text or
image, selecting Undo undoes the current Paste action but leaves
the information in the clipboard.

Clear
This command erases the entire contents of an image
window.

Select All
This command encloses the entire contents of a window.
This is often used for copying contents of window to another.
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Duplicate
Duplicate creates a new window with exactly the same
image as the one in the current window, and gives it the same
name with a suffix of 'copy'.

Cut out subregion
The Cut out subregion command is similar to Copy in
that you select a region (rectangle) of interest in a current image
without deleting it from the current image. It differs because
instead of copying the image to the clipboard, the image section
becomes a new window with the original windows name with the
suffix 'cut out'.

Convert to Greyscale
This command converts any colors in the current image
to grey. Useful if an image is going to be printed on a black and
white printer.

Convert hires to pixels
All lines, text, shapes, and anything created with the
'Drawing Tool Box' are actually high resolution objects. As with
most drawing programs, they are designed to be dealt with as
whole objects. It is difficult to cut or paste part of an object
created in the above manner. It is easier to work with the entire
object. If you wish to edit such an object, it may be easier to
invoke this command. Doing so will allow you to edit the objects
on a pixel by pixel basis. However, when printed, the lines may
not be as smooth as before, they may appear jagged.

Show hires as 300dpi
If you wish to edit drawn objects as described above, you
may want to show the high resolution image at 300dpi (dots per
inch). Saving and working with this type of image will retain the
smoothness of the lines.
Note: This command enlarges the image up 400%
in order to retain the smoothness of the lines in
the image. When printing, set the 'Reduction'
factor in the Page Setup dialog box to 25% in
order to print the image at the original size.

Show Drawing Tool Box
Fig. 14.2 The Show Drawing Tool Box
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This command brings up the DIAS® 'Drawing Tool Box'
(Fig. 14.2) The options under this tool box are standard to most
drawing programs. They will not be covered here. If you would
like additional information, you may use the 'Help Balloons'.

Option

XV
The Option menu
The Option menu
The Option menu (Fig 15.1) contains commands which
will give you different text and drawing options.

Select draw/text color
This command presents several color options to use with
the various drawing and text tools under the Edit menu (Fig.
15.2). To change colors, select that color with the mouse. The
selected color will have a box around it. For more choices,
double-click on the right most color. Doing so will bring up a
standard Macintosh® color choice system.

Font

Fig. 15.1 The Option menu

Fig. 15.2 A greyscale version of the
color choice palette.

Selecting this command brings up a submenu listing all
of the PostScript® and TrueType® fonts available to your system.
For some of the text files in DIAS®, selecting a different Font,
Size or Style from the menu with a window open will make those
changes to text in the window. You do not have to highlight the
text first. For other windows, the changes must be made before
creating the data.

Size
Selecting the Size command brings up a submenu (Fig
15.3) which gives you control over the character size in various
text windows. A checkmark shows the current settings.

Fig. 15.3 The Size command submenu

Style
The Style command works the same as the Font and Size
command, with a submenu (Fig 15.4) showing you the current
settings.
Fig. 15.4 The Style command submenu
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XVI
The Movie menu
The Movie menu (Fig. 16.1) includes commands for
controlling movie play, for editing and combining movies, and
for processing movies. These commands will work with both
QuickTime® and DIAS® movies, but will work fastest with
DIAS® movies.

Capture movie
As stated in the Making Movies chapter (III), DIAS®
may be used to analyze movies captured with other types of
software, or using its own, built-in, capabilities. DIAS® supports
most frame-grabbers which include their own, QuickTime® VDig file in the extensions folder. These include several Data
Translation frame grabbers and those models which come builtin to some Macintosh AV models.
In order to see if your model is supported, and to begin
the process, select Capture movie from the Movie menu. Doing
so will open a control panel listing those frame-grabbers available
to the program (Fig. 16.2). In this case, only the built-in AV
model frame grabber is listed.
After clicking on the desired model, a dialog box will
give you control over the capture process (Fig. 16.3). In this
dialog box, you will need to enter the time 'Interval', or length of
recording time, the number of frames you wish to record, and the
size of the recording window.
DIAS® also allows you to average frames, and to only
grab frames based on an amount (percentage) of motion detection/
change. If you are grabbing frames in a nonconsistant manner,
either by manually selecting frames, or by selecting frames based
on motion, you should choose to 'Time stamp frames' for
periodicity accuracy.
After making all of those choices, a window will appear
on your desktop with the movie playing within it. You
will be asked to select a region of interest, and to press the
return key when you are ready to begin recording.
The recording process will continue through the
end of the selected cycle, or until you press the Apple and
period '.' keys simultaneously. Once your movie has been
recorded, you will go through the same saving process as
covered in the Making Movies chapter (III).

Figure 16.1. The Movie menu.

Figure 16.2. The frame-grabber
selection dialog box..

Show Movie Control
When you Open a movie from the File menu, a

Figure 16.3. The 'Set Parameter' dialog.
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Figure 16.4. The movie player control
panel.

window containing buttons for controlling the playback of a
movie will automatically appear in the lower right hand corner of
your computer screen (Fig. 16.4). You may close that control
panel at any time. If you wish to open this window again later,
select Show Move Control from the Movie menu.
To play a movie, select the|> button. This will play all
open movies at the same time. To advance forward or backward
frame by frame select the |>|>| or |<|<| buttons, respectively. To
stop the movie from playing, click the square button; to advance
the movie to the last frame or rewind it to the beginning, select
the |>|> and <|<| buttons, respectively.

Forward, Rewind, Goto Frame, Next Frame Previous
Frame and Play
These commands are self-evident, and will not be covered
here.

Frame Rate
The Frame Rate command allows you to view your
movie(s) at different rates based on frames per second. A dialog
box will give you the option to change frame rates. Enter an
integer value or 'max' for the fastest.

Frame Increment
This command allows you to skip frames while viewing
your movie(s). After selecting the menu item, you are presented
with a dialog box asking for a new increment. An increment of 3
means you would view frames 1, 4, 7, 10, etc. The default is 1.

Loop
This command allows you to play the movie continuously,
over and over again, through a desired number of frames. When
first selecting this command, a dialog box will ask for the desired
first and last frames of the loop. Make sure the first frame
number is greater than or equal to the last frame number.

Play All Movies
Play All Movies allows you to simultaneously play
multiple movies at once. This works for any movies opened by
DIAS®.

Process Movie Images
This command allows you to use the Quick Processing
image processing capabilities explained in the next chapter on
whole movies.
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Merge movies end-to-end
This option allows you to combine two movies into one,
longer movie. When you select this option, a series of standard
Macintosh® Open dialog boxes will appear in order, asking you
for the names of the movies to open. The first movie you select
will become the first part of the movie, and the second part of the
movie will be constructed from the second movie you choose.
After you have chosen the two movies, a dialog box will ask you
for the name of the new movie. When you have made your
selection, the two movies will appear on screen, and play, one at
a time, end to end. It is only at this point that the merging takes
place, so do not attempt to stop the process. After both movies
have played through, you can open the new movie and play it, or
merge it again with another movie.
Note: The first movie you pick determines the
size of the total movie. If the first movie is
smaller, in screen size, than the second. The
second will be cropped to match.

Merge movies parallel
This command allows you to merge the paired frames of
two movies. For each movie, each paired, matched number of
frames is combined. For instance, frame 1 from movie 1 is
merged with frame 1 of movie 2, etc. This command is designed
to combine greyscale and color movies. This is useful for
combining movies made with the commands under ViewPaths,
with the original greyscale background.
After selecting this command, two dialog boxes will
open, asking you for the names of the movies. Select the
greyscale movie first, as that becomes the background image,
and the color information from the second movie will appear on
top of those original images.

Montage Movie
This command allows you to view individual frames
from your movie as a table of single frames. After selecting this
option a dialog box will ask you for the number of frames across
and down to display, followed by another dialog box asking
which frame numbers to include. Once these options are selected,
another dialog prompts you to choose whether or not to draw the
frame numbers on the frames displayed.
Having made those choices, the frames will be displayed.

Stabilize Movie
This option allows the user to correct a movie which was
recorded with continued, undesired movement or jitter. If your
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Figure 16.5. The first 'Select Method'
dialog box.

Figure 16.6. The second 'Select Method'
dialog box.

movie contains only occasional jumps, due to stage movements,
use the Join Stage Movement command, described in chapter
IV. To 'Stabilize (a) movie' make sure that it is open on the
desktop, and select the command from the Movie menu.
There are two major methods for stabilization, picking
known points, or frame comparison. Using the known points
method, you click on a known, non-moving point on every frame
of the movie. DIAS® then realigns all of the frames in the movie,
based on the matching of those points and clicks. The second
method gives you more control over each frame, and involves
comparison of each pair of frames in the movie. After first
selecting Stabilize Movie, a dialog box will ask you to select
from these two different methods (Fig. 16.5).
If you select the 'Known points' method, you will click on
those known points throughout each frame of your movie. If you
select the 'Frame comparison' method, a second dialog box will
allow you to select between two variations in that method (Fig.
16.6). Each of the methods allows you to select an original
rotational point, and then to use your up, down, right and left
arrow keys to move the frames, as they jump back and forth
between sequential pairs of frames. The idea is to look at the
movement of items as the frames shift, and then fine-tune the
stabilized matching. You move to the next set of frames by
pressing the return key.

Detect Vector Movement
Frame F

Frame F + 1

Best match
Original kernel

Kernel around
Point-of-interest
Kernel moved to all positions
within a certain radius
Frame F + 1

Resulting vector arrow points
in direction of movement and
length is amount of movement

Figure 16.7. A vectoring example.
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It is not always possible to
adequately outline cells. This is
particularly true in cases of
aggregation, waves, or other
phenomenons that involve large
crowds of moving cells or objects. In
those cases, vectoring may be helpful.
Vectoring is the process of
analyzing moving and changing grey
values. No outlines or traces are
needed. In this procedure, a grid of
points spaced at 5-pixel intervals was
superimposed on the cells. The
program then connected a point in one
frame with a point in the next frame by
forming a kernel square around the
first point and then finding the “best
fit” of video pixel data within the kernel
by moving it to all positions within a
certain radius from the original position
and comparing the video data to the
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original. When the best fit is found, a vector is drawn connecting
the center of the original kernel to the center of the moved kernel
(Fig 16.7). You may regulate the size of the kernel and radius.
Thus, DIAS® generates vectors, the length of which are
proportional to the net distance the kernel has traveled and the
direction of which represents net direction of travel.
It takes two steps to completely analyze vectors. First
you must create a vector movie, using the Detect Vector
Movement command. Once selected, a dialog box (Fig. 16.8)
allows you to define the 'Kernel size', or the area, in square
pixels, over which the comparison will be made for vectoring.
You may also define the maximum area of movement allowed
before a vector will be disallowed. The rest of the dialog box
allows you to define look of the vectors drawn. After you have
entered the settings, press the return key, and you will be asked to
choose a region for which to detect vector movement. The
process then begins, creating and displaying the vectors for each
new frame. It works by comparing each frame with its previous
frame and calculating the change in position, as described above.
This results in one less frame than your original movie because
the first frame does not have vector movement, only the second
frame in comparison to the first frame has a change in position.
When this step is finished, the result is a new movie with the
vectors of motion marked over the body of each cell within the
region you selected. You may play this movie to show overall
movement, or you may analyze the vectors themselves, using the
Analyze Vector Movement command.

Figure 16.8. The 'Detect Vector
Movement' dialog box.

Analyze Vector Movement
This command is designed to analyze, for motility, the
vectors created using the previous command.
To do so, with the newly created vector movie open,
select this command from the Movie menu. Doing so will place
the movie in a larger window, with a small amount of white,
bordering the new movie. The vector movie will play, giving
you a chance to view the movie. In the titlebar of the movie
window, it will tell you to type 'w' in order to window. Do this
now, and select an area of the vector movie to analyze. After
doing so, the titlebar will ask you to indicate a direction. To do
so, draw a line within the rectangle in the direction of general
movement. This will tell the program how to analyze positive
and negative directionality. Finally, the title bar will ask you to
'place' the graph. Move the mouse pointer somewhere outside of
the rectangle of interest, but within the movie window.
After doing so, the titlebar will again ask you to select a
window. If you wish to analyze more than one area of the movie,
continue on as described above. Once you have made all of your
16.5
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choices, click the return key, and DIAS® will create a small
graph, showing directionality of movement.
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XVII
The Image menu
The Image menu
The Image menu (Fig 17.1) contains image processing
and correction commands designed to work with static images.
Before selecting any of these commands, you must have an
image open on the desktop.

Adjust contrast
Selecting Adjust Contrast adds the current image's gain
and brightness settings and a '?' to the menubar of the currently
open image (Fig. 17.2). Typing '?' shows you the contrast
adjustment commands (Fig. 17.3).
Click on the up key on your keyboard up to increases the
image's contrast, moving it down to decreases contrast, pressing
the left arrow key decreases brightness and right increases
brightness. The image and numbers will change as you move the
mouse. When you have finished adjusting the contrast, press the
return key.

Fig. 17.1 The Image menu

Invert
This option will create a negative (Fig.
17.5) of your original image (Fig 17.4), or if you
have scanned in a photographic negative, Invert
will reverse it into a standard image.

Fig. 17.2 The current settings listings.

Smooth
This command automatically smooths the
entire image; it softens edges of lines and blurs
them so that edge detection is less sensitive (Fig. 17.6). To view
further options available under this menu item, hold down the
'option' key while selecting Smooth and it will bring up a dialog
box with two more options. The first text field asks for the
number of times you would like the image smoothed; more
numbers result in more smoothing. The second text field is
labeled 'Kernel' and gives you a choice of 4 numbers (3,4,5,7). It
results in a heavier smoothing factor with higher numbers.

Fig. 17.3.
options.

The contrast adjustment

Sharpen
Figure 17.7 is an example of sharpening. Holding down
the 'option' key provides additional sharpening controls.

Fig. 17.4 The original image

Difference
In differencing, the image is subtracted from itself, which
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gives it a 3-dimensional appearance (Fig 17.8). The amount and
direction of the differencing may be controlled by the arrow keys
on your keyboard.

Edge Detect

Fig. 17.5 The inverted image

This filter finds the minimum intensity in each defined
kernel and subtracts that intensity from the center pixel's intensity.
This is done for all pixels. The result may enhance the edges of
the image (Fig. 17.9).

Unwarp Image

Fig. 17.6 The smoothed image

Fig. 17.7 An example of sharpening

Fig. 17.8 The original image differenced
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Unwarp image has two different components, unwarping
based upon a set of guiding lines, and aligning. When first
selecting this command, a dialog box will ask you if you wish to
'Slide adjust?' (Fig 17.10). If you select 'Yes' the title bar will ask
you to 'Select region to adjust' (Fig 17.11). After selecting a
region, or pressing the return key which selects the entire image,
a dialog box will ask you for an 'Orientation' for aligning (Fig
17.12). Selecting 'Horizontal' means that you will be able to
stretch, slide and compress the image (or section of the image) to
the right and left. 'Vertical' gives you the same ability, moving
up and down. Once you have selected an orientation and section,
to unwarp your image, click on the image and move it. If you
click on the center of the image and move, you will slide the
entire selected area. If you click on an edge (right or left for
horizontal orientation-top or bottom for vertical orientations)
and move in the direction of that edge (you click on the right side
and move farther right), you will stretch the image, if you move
opposite of the side you click on, you will compress your image
(or section of the image).
If you answer no to the 'Slide adjust?' question, you will
be shown another dialog box asking you wether you wish to 'Use
simple line segments?'. The type of line segments you use will
depend on the types of distortions in your image. Simple line
segments, which are straight, unkinked lines, are used in cases of
continuous skews in an image. To draw simple line segments,
click and drag the mouse to draw horizontal lines along the
known skews in the image. Because simple line segments are
straight, unkinked lines, when drawing them, you need only click
and drag the mouse a short distance. DIAS® will finish the line
for you, extending it the entire horizontal or vertical distance of
the image. If the distortions in the image involve kinking, simple
line segments would not effectively straighten the image.
Complex line segments are a series of short, connected
lines (Fig 17.13). To draw 'Complex line segments', click and
drag along the known skews as you would with 'Simple line
segments', but when you reach a kink or bend, release the mouse
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button to end a segment and then re-click and continue to create
the 'Complex line segment'. Because of their complexity, after
finishing each horizontal or vertical line segment, you must press
the return key to finish the line before continuing to the next, or
you will create a series of connected, zig-zagging lines.
When using either simple or complex line segments, it
does not matter in what order you draw the lines. You can start
with horizontal or vertical lines, and continue either right to left
or vice-versa. The same is true when starting at the top or
bottom. DIAS® is flexible. As long as the lines you draw are
relatively horizontal or vertical, DIAS® can interpret the guide
lines. The only caveats are that you can not 'box' your image with
one continuous line; you must box in your gel with at least two
horizontal, and two vertical lines. The more horizontal and
vertical lines you draw, the better unwarping job DIAS® will be
able to do. This is true because DIAS® works the with subblocks of the image created by the intersecting horizontal and
vertical lines, and the more blocks the image is broken down
into, the more control DIAS® has over the image.
Looking at the title bar, it tells you to type 'd' when you
have finished. After doing so, a new blank window will open,
and your image will start to rebuild itself piece by piece (these
pieces are based upon the cross sections created by the intersecting
horizontal and vertical unwarping lines) (Fig 17.13).

Multi Processing
When you first select Multi Processing, a rectangle
appears on your image. You use this rectangle to select an area to
use as a test region. Once you have done this, two copies of the
test region and the multiprocess control panel appear on screen.
The Multiprocess command allows you to use several image
processing filters at the same time and in progression. Since the
filters have already been explained, they will not be covered
here. To use a filter, click on the box to the immediate left of it.
For some of the filters, you can use multiple 'Iterations'. There
are 4 'Processors' so that the filters can be applied in progression,
instead of all at once, which may cause problems with the image.
The image on the left is the original, and the image on the right
represents the original after all of the filters have been applied.
Once you have chosen specific filters, you can see their effect on
other parts of the image by using the various scroll buttons. You
can also save and load filter settings.

Fig. 17.9 The original image after the
edge detect filter is applied.

Fig. 17.10 The first dialog box after
selecting Unwarp
Fig. 17.11 The title bar of the window
during Unwarp

Fig. 17.12 How to choose aligning
techniques during Unwarp

Fig. 17.13 The original image with nonsimple (complex) line segments drawn
for unwarping

Quick Processing
Quick Processing allows the user to adjust the brightness
and contrast for an entire image. It is similar to Multi Processing
in this respect, except that is displays various processing outcomes

Fig. 17.14 The unwarped image
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Figure 17.15. The multiprocess control
panel.

simultaneously, for comparison. Brightness is decreased as the
choices go to the right, and contrast is decreased as the choices
go down the columns.
There are several other options available to the user at
this point. To see them while the program is running, hit '?' at this
time and a legend will appear. 'B' results in all of the available
choices becoming brighter than they currently are, 'd' results in
the choices becoming darker , and 'i' results in the image becoming
inverted.
If further choices modeled after a particular contrast and
brightness selections are desired, that selection's number may be
typed and other filters will be derived from that choice. For
example, if the user desires a filter similar to choice number 3, he
or she can type '3' and 12 new filters based on choice 3 will be
created. This allows for finer adjustments in shading and contrast
than were presented to the user at first.
After a filter is selected, a dialog box asks the user
whether to apply the processing to the entire image or not. 'Yes'
results in the whole image being affected; 'no' results in just the
processing box which was initially selected being processed.

Flip Image 90 deg
This command takes the original image and flips the
window 90 degrees to the right (Fig 17.16).
Fig. 17.16 The image rotated 90 degrees

Mirror Image
This option reverses the image from right to left (Fig
17.17).

Enlarge/Reduce
Selecting this command brings up a dialog box (Fig
17.18) asking you for percentages of reduction or enlargement.
Be sure to use the same percentage for both the 'Horizontal' and
'Vertical' settings, or you may distort your image.
Fig. 17.17 The mirror image of the
original gel

Rotate

Figure 17.18 The Enlarge/Reduce dialog
box.

The Rotate command is similar to the Flip Image 90 deg
command in that it allows you to rotate your image. There are,
however, two very important differences between the two
commands.
The first difference is that this command gives you control
over how much to rotate the image. This is useful if the image is
slightly skewed, and not completely turned around. When first
selecting this command (with the desired image open and on the
desktop), a dialog box (Fig 17.19) will ask you to 'Select center
of rotation'. This is the point around which the rest of the image
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will be rotated. This will generally be center, but you can pick
any point in the image. After making your selection, a second
dialog box will ask you the 'Angle', in degrees, you wish to rotate
the image (Fig. 17.20).
This ability brings up the second important difference
between the two commands. Because the rotation angle need not
be in increments of 90 degrees and the image can rotate on any
point, the image may no longer be rectangular in nature. This
being the case, DIAS® cannot create a new non-rectangular
window, so it rotates the new image within the existing window.
Thus, portions of the image may be cut off. To eliminate this
problem, we recommend creating a New Image window much
larger than the original, and copy the image to the center of the
new window. Now, when you rotate the image, there should be
enough room to fit the entire image in the window, and after you
are done, you can Cut out (a) subregion of the new image to
eliminate any leftover white area.

Fig. 17.19 The rotation center dialog box

Add, Subtract, and Merge images
These three commands are all designed to allow you to
combine images. With most cut and paste commands, anything
under the area of the image you paste is erased. With these three
commands, you may combine images without losing the
information below.
Before you can use these commands, you must have two
images open on the desktop. Add Images transparently pastes
the background image on top of the foreground image. Subtract
images transparently pastes the negative of the background image
on top of the foreground image. Both of these commands are
designed for use with greyscale images because the backgrounds
of the images may blur when the actual images are combined.
With the Merge images commands, the backgrounds are not
combined, so less of the blurring occurs. The choice of which
merge command will depend on the background of the images
being merged. The merge command is similar to Add Image,
but is better for images with high-resolution lines and drawings,
such as graphs.
Experiment with these three commands in order to obtain
the best results.

Figure 17.20 The Rotate dialog box.
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XVIII
Measure Menu
Measure Menu
The Measure menu (Fig. 18.1) contains commands
allowing you to make measurements of static images, based on
the relative lightness and darkness of the pixel data composing
the image. An image must be open before these options become
available.

Calibrate Scale
This command allows you to change the length scale of
measurement from pixels to another unit. The user is prompted
for the scale factor and for the unit (Fig. 18.2). If the scale factor
is known, it may be directly entered. If '?' is entered for the scale
factor, the user is prompted to draw a line of known length on the
image and is then asked for the length of that line. The scale
factor is then automatically computed. Each window has its own
scale factor.

Calibrate Luminance
With this option you may change the luminance scale
from 0(black) - 255(white) to a custom scale. The title bar of the
open window will prompt you to select points on the image and
enter the desired luminance value (Fig. 18.3). Up to 16 sample
points may be given. Type the 'return' key to exit. Luminance is
now computed by linear interpolation from the given values.
Note: Even in a custom scale, darker intensities
should have lower values than lighter ones.

Fig. 18.1 Measure menu.

Fig. 18.2 'Calibrate Scale' dialog box.

Fig. 18.3 'Calibrate Luminance' dialog
box.

Display Luminance LUT
Selecting this command shows the graph of the LUT
(look up table) where output luminance (in the calibrated scale)
is given as a function of input luminance (Fig. 18.4).

Point Luminance
After selecting this command, you may click on any
point with the mouse and the luminance value appears in the
titlebar of the window. A text insertion bar appears, allowing
you to indicate where the value will be displayed. Press the
return key to exit.

Fig. 18.4 'Display Luminance LUT'.
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Simple Length
This command gives the length of a line drawn using the
mouse. It also gives the angle of the line in degrees. This
information will appear in the lower left hand corner of the open
window. Press the return key to exit. This option may serve to
estimate lengths of interest, such as the cell body or nucleus
length.

Arbitrary Length
This command measures the length of curves traced with
the mouse. Draw a curve by holding the mouse button down,
while moving the mouse, or by point-to-point clicking. Press the
spacebar when done. A text insertion bar appears; position it and
click to have the length of the curve tagged to the image. More
curves may now be drawn. Press the return key to exit. This
option allows the calculation of the total length of a curved
surface.

Arbitrary Area

Fig. 18.5 Expert analysis for 'Arbitrary
Area' dialog.

Arbitrary Area measures the area of simple regions drawn
with a mouse. When first selecting this command, a dialog box
prompts you to choose 'Expert analysis' or not (Fig 18.5). Expert
analysis measures perimeter length, area, roundness as well as
several other shape parameters, and presents these results in a
tabular form. Once the region is drawn, the area parameters are
calculated and then you may draw another region to be analyzed
or press the return key to exit this mode.

Arbitrary Luminance
The instructions to using this command are displayed in
the window's title bar when this option is selected. After drawing
a shape of any size and pressing the spacebar to close the region,
the mouse places the text which contains information about the
luminance of the region. Press the return key again to finish with
this option.

Threshold Count

Fig. 18.6 'Threshold Count' dialog.

This command allows the user to enter a threshold value
for which pixels are to be counted within a region (Fig. 18.6).
The result is a fractional number representing the number of
pixels at or above the threshold value over the total number of
pixels. You may again select where the notation should be
printed.

Densitometry of a Horizontal Slice
After selecting this command, box in a horizontal slice of
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your image. For each horizontal position within the rectangle,
the intensities of the pixels (on the vertical line) in the rectangle
with the same horizontal position are averaged. If background
subtraction is requested, a duplicate of the first rectangle replaces
the arrow cursor. You are then asked to position this rectangle to
sample the background luminance. These luminance values are
then subtracted from the luminance values of the original slice.
If the background is darker than the original slice in over 20
locations, the subtraction is canceled. After the luminance graph
appears, areas under the graph can be computed. The horizontal
line across the bottom of the graph is the base line based on the
lowest point of the luminance graph. Dialog boxes prompt the
user to indicate the left and right boundaries with the mouse.
Once the area of the bounded region has been found, you place it
in the window with the mouse.

Densitometry of a Vertical Slice
This command works similarly the horizontal
densitometry, except the slice is oriented vertically.

Densitometry of arbitrary slices
When choosing this command, you can type any of the
number keys 1-9 in order to increase the thickness of the slice.
You then draw the line (slice) with the mouse. The rest of the
steps are similar to those described above.
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